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ABSTRACT

PrePro2004: A Data Model with Pre-and-Post Processor for HEC-HMS.

(August 2005)

Ashish Agrawal, B.E., Bhilai Institute of Technology, India

Chair of Advisory Committee: Dr. Francisco Olivera

This thesis presents the design concepts and development ofan interface (Pre-

Pro2004) utilizing geodatabases for the Hydrologic Modeling System (HMS) of the

Hydrologic Engineering Center (HEC). HMS is a rainfall-runoff model which supports

lumped-parameter as well as distributed-parameter based modeling. PrePro2004 uses the

spatial-analysis as well as data handling capabilities of ArcGIS. The spatial data are pro-

cessed to create input files for HMS. These input files and the output from HMS are stored

in two geodatabases which were developed using data model concepts. The tools are pro-

vided to reproduce an HMS model from the data inside these geodatabases. The interface

is developed based on the DataCentric approach which brings different hydrologic and

hydraulic models together. This approach aims to attain a long-term goal of utilizing the

same data for different hydrologic or hydraulic models withadditional model specific

requirements.

Two case studies are presented to show the applications of the tools developed. The

first case study details the creation of HMS input files for Salado Creek watershed with

Digital Elevation Model as input. It includes the importation of an existing HMS model

for Salado Creek watershed as Appendix C. The second case studydetails the creation of

HMS input files for the Bull Creek watershed, with land use and soil type data as inputs.

It describes the capabilities of tools developed in detail.
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CHAPTER I

INTRODUCTION

The engineering field, including water resources engineering, evolves and changes

as new technology becomes available to the engineers. The tasks of flood estimation,

flood plain mapping, and sustainable development of water resources aim to improve

the quality of human life. Thus, accurate runoff estimationbecomes very important for

surface water hydrologic modeling. This accurate estimation largely depends upon the

hydrologic data provided to the rainfall-runoff model. Given the complexity of water

quantity and quality models, creation of input data for themis extremely challenging.

This was also observed and stated by Bhaskar et al. (1992) “thecompilation of input hy-

drologic data for empirical as well as sophisticated discrete-system rainfall-runoff models

is often cumbersome”.

Although the use of mathematical models in the form of software for hydrologic en-

gineering increases the efficiency and flexibility of water resources modeling, they need

intensive data development for input such as the time of concentration, lags, Soil Con-

servation Services (SCS) curve numbers, and channel routingparameters (Ogden et al.,

2001). One such mathematical hydrologic model is the Hydrologic Modeling System

(HMS), developed by the Hydrologic Engineering Center (HEC) of the U.S. Army Corps

of Engineers (USACE). Part of input data for HMS depends on topography of the area un-

der study and needs spatial analysis techniques to extract geomorphic, topographic, and

hydrologic information. HMS supports both lumped-parameter-based modeling as well

as distributed-parameter-based modeling. Since use of distributed modeling approach in-

This thesis follows the style ofASCE Journal of Hydrologic Engineering.
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creases the amount of data to be handled, the data managementprograms like HEC-DSS

and Arc/Info are popular (Kull and Feldman, 1998). Geographic information systems

(GIS) prove to be a useful tool with its spatial analysis algorithms and data-handling

capabilities.

Environmental Systems Research Institute (ESRI) is a leadingproducer of GIS soft-

ware and has greatly influenced the market. Arc/Info was their first major software prod-

uct, followed by ArcView. Arc/Info provided the advanced spatial analysis techniques,

and ArcView provided the visualization and display capabilities. Later, some of the spa-

tial analysis functions of Arc/Info were incorporated intothe later version of ArcView

which has graphical user interface (GUI). In 2000, ESRI released a new software product

called ArcGIS. ArcGIS 8.x series is a suite of four components: ArcView, ArcEditor,

Arc/Info, and ArcReader. The later version of ArcGIS brings geographic information

systems in the mainstream information technology industryby supporting Component

Object Model (COM) and Extensive Markup Language (XML) (ESRI,2004). Recently,

ESRI released a new version, ArcGIS 9.0, with additional capabilities.

A. Motivation

The use of GIS to preprocess input data for HMS has been discussed in the liter-

ature by Maidment and Hellweger (1999) and Olivera (2001). Most of the preproces-

sors in ArcView 3.x were developed using the Avenue scripting language. Avenue is

a ESRI-proprietary scripting language. Although Avenue is an object-oriented program-

ming language it can not take advantage of Microsoft’s COM technology: in other words,

Avenue does not allow to use statistical, analytical, and visualization softwares outside

the ArcView environment.

ArcGIS 8.x series supports Visual Basic, a COM-compliant language, for customiza-
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tion purposes. ArcGIS exposes its functionality through ArcObjects which can be used

by VB6, Visual C++, VB.NET, and C# to customize GIS functionality. ArcGIS intro-

duced a database structure called Geodatabase, a RelationalDatabase Management Sys-

tem (RDBMS), which allows storage of spatial and temporal datatogether. Geodatabase

is implemented using a standard relational database management system such as MS Ac-

cess. Recently, ESRI introduced the data model concept. According to ESRI (2004)

a data model is “an abstraction of the real world that incorporates only those properties

thought to be relevant to the application at hand. It would normally define specific groups

of entities, their attribute values, and the relationshipsbetween these. In GIS, it is often

used to refer to the mechanistic representation and organization of spatial data; for ex-

ample, the vector data model and the raster data model.” Basedon this concept, Obenour

et al. (2004) developed anInterface Data Model for HEC-HMS. It should be noted that

data model is not a simulation model in itself, but only a repository to store and manage

data.

The above stated reasons have lead to the development of an interface to link the

HEC-HMS data model with HEC-HMS modeling software.

B. Objectives

There are various strategies for coupling GIS with hydraulic and hydrologic mod-

els. Shamshi (1998) defined three levels of complexities forlinking GIS and hydrologic

model: interchange,interface,and integration. Interchange is the lowest level at which

selected information exchange will take place between GIS and the model. At Interface

level, GIS performs pre-processing, model execution, and post-processing. Interchange

level is the most complex level that requires change of the model structure to either in-

clude GIS or create the model itself in GIS.
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Ungerer and Goodchild (2002) defined coupling strategies for GIS and statistical

analysis package. These coupling strategies can be used to link GIS and hydrologic

modeling packages as well. Table 1 details the strategies proposed by them.

These coupling strategies aim at utilizing the spatial analysis capabilities of GIS. In

this thesis, a new coupling strategy is proposed that aims toinclude both data-handling

and spatial-analysis capabilities of GIS. The coupling of hydrologic modeling and GIS

can be termed either asModelCentricor DataCentric. ModelCentriccoupling is the

design and integration of hydrologic model with GIS components. This resulting system

is centered around the hydrologic model. In this strategy, GIS may be used for pre-

and/or post-processing data for the model but storing of model data is done in the format

required by the hydrologic model.DataCentriccoupling is the design and integration of

a hydrologic model with GIS components. The resulting system is centered around the

data. In this strategy, GIS may again be used for pre- and post-processing data for the

model, but the storage of the model data is done in a standard format; e.g. geodatabase

data model. The DataCentric approach will allow utilizationof the same data, in part

or whole by little customization, by another hydraulic or hydrologic model. This thesis

details the creation of an interface using DataCentric approach.
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TABLE 1. Coupling Strategies for GIS and Hydrologic Models (Ungerer and Goodchild, 2002)

Strategy Isolated Loose Close Integrated
Description Analysis and output

display directly in spa-
tial analysis software

Analysis in spatial
analysis software;
output display in GIS,
facilitated by online
file exchange

Analysis method
varies; GIS and anal-
ysis package share a
common database

Analysis and output
display directly within
GIS

Advantages Limited overhead in
terms of code creation

Spatial Analysis can
be done from within
GIS

No file import or ex-
port, no code creation
required

Disadvantages Abundant GIS layers
could not be used

Time consuming to
import and export data

Overhead in terms of
code creation

Possible lack of spe-
cialist insight in spa-
tial analysis
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C. Terminology Overview

The terminology related to ESRI’s software that is used in this thesis is described

below. The definition for these terms can be found in standarddocuments. This thesis

takes from ESRI’s website〈www.esri.com〉.

Featureis the representation of real-world object on a map. Features can be repre-

sented as vector data (such as point, line or polygon) or as cells in raster data format.

Shapefileis a vector data storage format for storing the location, shape, and attributes

of a geographic feature. In this thesis [ ] is used to represent a shapefile.

Rasteris a grid data format in which the vector data is stored as an array of equally

sized cells arranged in rows and columns. Each cell has an associated cell value and

location coordinates. Groups of cells sharing same value represent a geographic fea-

ture. The words “Raster,” or “Raster grid,” or “grid,” or “Arc/Info raster grid” are used

interchangeably in this document.

Geodatabase data modelis a geographic data model that represents real-world geo-

graphic features as objects in an object-relational database.

Geodatabaseis an object-oriented data model. It represents geographicfeatures as

objects and their behavior as attributes. It also stores relationships among objects within

the relational database management system. A geodatabase can store objects, such as

feature classes, feature data sets, non-spatial tables, and relationship classes.

Feature classis a collection of geographic features having similar same geometry

type (such as point, line or polygon), attributes, and spatial reference. In this thesis,{ }

is used to represent a feature class object of geodatabase.

Feature datasetis a set of feature classes that share the same spatial reference and

fall within the same extent but not necessarily store the same type of feature (such as

point, line or polygon).
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Table or Object classis a set of data elements arranged in rows and columns. In this

thesis,〈 〉 is used to represent a table object of geodatabase.

D. Thesis Outline

This thesis consists of six chapters. Chapter I presents the introduction, motivation,

objectives, and overview of terminology. Chapter II presents the literature review of exist-

ing interfaces for hydraulic and hydrologic model. Chapter III presents the methodology

describing:

• The extraction of hydrologic and topographic information from geospatial data

• Storing the extracted data in the geodatabase data model

• Creating input for HMS

• Reading output as well as existing model data to store them in geodatabase data

model.

Chapter IV presents the application of the developed tool with results and discussion.

We conclude with final remarks in Chapter V. Appendix A describes the format of tables

required by PrePro2004. Appendix B and C present the user manuals for PrePro2004.
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CHAPTER II

LITERATURE REVIEW

The literature review discusses existing pre-and-post processors and data models for

hydraulic and hydrologic models. This section is divided into three parts. The first part

briefly discusses hydrologic and hydraulic models, and existing GIS-based interfaces for

these models. The second part discusses data model conceptsand some of the existing

data models relevant to this paper. The third part summarizes the inferences drawn from

the first and the second part.

A. H&H Models and Interfaces

1. Hydrologic Modeling System (HEC-HMS)

Hydrologic Modeling System (HEC-HMS), developed by Hydrologic Engineering

Center of U.S. Army Corps of Engineers, is a set of mathematicalmodels to simulate the

precipitation-runoff-routing processes of dendritic watershed system (HEC-HMS, 2001).

HMS needs three input components: the basin model, the meteorological model, and the

control specifications. The basin model is the representation of real-world objects with

parameters describing their behavior. The basin model elements are subbasin, reach,

junction, source, sink, reservoir, and diversion represent subbasin, river reach, point of

intersection of river reaches, input flow point to basin system, outlet of the basin system,

reservoir, and diversion for a reach in the real world, respectively. Each of these elements

needs some parameters to define their behavior in a hydrologic system. Each element

stores the element downstream to it to facilitate the flow of water and to create a dendritic

network. The meteorological model stores the information of precipitation falling on the

watershed and evapotranspiration. HMS supports six different historical and synthetic
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precipitation methods as well as one evapotranspiration method (HEC-HMS, 2001). The

historical precipitation data can either come from precipitation gages, which will lead

to lumped-parameter basin modeling or from radar data, suchas Next Generation Radar

Rainfall Data (NEXRAD), which will lead to distributed-parameter basin modeling. Spa-

tially distributed runoff is calculated using ModClark transform method in conjunction

with Gridded SCS Curve Number or Gridded Soil Moisture Accounting loss methods.

ModClark is a quasi-distributed linear transform method. HMS needs a grid-cell file to

use the ModClark transform method. The grid-cell file contains coordinate information,

area, and a travel time index for each cell in the subbasin (HEC-HMS, 2001). The control

specification component is used to describe the time period and time step for simulation.

The input time-series and other paired-value data are stored in HEC’s Data Storage Sys-

tem (DSS). The output of HMS includes peak flow and total volume for each element in

the basin model. These output data are also stored in DSS. Thus, overall data storage and

management in HMS is attained by using flat files (ASCII and binary) as well as the DSS

file. Two of the existing interfaces to pre-process spatial data and to create HMS input

files are discussed here:

a. CRWR-PrePro

CRWR-PrePro is an hydrologic modeling extension developed at Center for Re-

search in Water Resources (CRWR) at The University of Texas at Austin. It was de-

veloped to work with ESRI’s ArcView 3.x platform and Spatial Analyst Extension. It

could generate input files for lumped basin model of HMS. Also, it can calculate the Soil

Conservation Service (SCS) curve numbers for SCS CN loss-rate method, the lag-time

for SCS unit hydrograph transform method, and the Muskingum and pure lag parameters

for flow routing in streams. Olivera (2001) presented the concepts behind the methodol-

ogy to extract hydrologic information from geospatial datato support modeling with the
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HMS. These concepts are basic in nature and have been used to establish linkage between

GIS and hydrologic models (Valenzuela, 2003).

b. HEC-GeoHMS

HEC-GeoHMS is a geospatial hydrologic modeling extension developed by HEC

for expedite construction of hydrologic models rather thanusing manual methods (HEC-

GeoHMS, 2003). It has been developed for ArcView 3.x platform and needs Spatial

Analyst Extension. Version 1.1 has the capability to generate the following input files for

HMS: a background map file, a lumped basin model file, a grid-cell parameter file, a dis-

tributed basin model file, a meteorological model file based on the user gage-weighing

method, a control specifications file based on user inputs, and hydrologic parameters.

Hydrologic parameters calculated by GeoHMS are lumped and gridded curve numbers,

time of concentration, and Muskingum-Cunge routing parameters by user-provided ad-

ditional information in the form of Excel spreadsheet. HEC-GeoHMS does not support

the creation of reservoirs and sources for the basin model.

2. River Analysis System (HEC-RAS)

The River Analysis System (HEC-RAS) is a hydraulic model developed by HEC-

USACE. It performs steady and unsteady flow, one-dimensional, water surface profile

calculations. Its components – hydraulic analysis computation model, data storage and

management module, and graphics and reports module – can be accessed through user-

friendly GUI (HECRAS, 2002). The data storage and management is again attained by

using flat ASCII files and the DSS file, as in the case of HMS. The linkage of GIS with

HEC-RAS is achieved in various ways. Two of them are discussed here.
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a. HEC-GeoRAS

HEC-GeoRAS is an ArcView extension to preprocess the geospatial data that pro-

duces input for HEC-RAS and reads the simulation results of HEC-RAS (HEC-GeoRAS,

2000). It preprocesses Digital Terrain Model (DTM) to create a geometric data input file

that can be imported into HEC-RAS. HEC-GeoRAS can read the results exported from

HEC-RAS. These results can further be analyzed to delineate a floodplain.

b. After HEC-RAS

Tate et al. (2002) harnesses GIS to create floodplain map. They utilize the HEC-RAS

simulation result, Digital Elevation Model (DEM), and stream thalweg data to create a

Triangular Irregular Network (TIN) for the stream floodplain. This is an example of

linkage of a model with GISafter running the model.

3. Soil and Water Assessment Tool (SWAT)

Soil and Water Assessment Tool (SWAT) is a physically-basedhydrologic model

resulted from work of Dr. Jeff Arnold for United States Department of Agriculture –

Agricultural Research Service (USDA–ARS). SWAT is used to “predict the impact of

land management practices on water, sediment, and agricultural chemical yields in large

complex watersheds with varying soils, land use, and management conditions over long

periods of time” (Luzio et al., 2000). Therefore, it needs anextensive amount of in-

put data which as well produces output data spanning severaldecades. To handle such

amount of data, GIS proves to be a useful tool. Some of the existing linkage between

SWAT and GIS are as follows:
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a. AVSWAT (ArcView SWAT)

AVSWAT (ArcView SWAT) is a comprehensive set of tools embedded in ArcView

3.2 version of GIS, developed in Avenue Scripting language.AVSWAT can perform

watershed delineation, allow definition and editing of hydrologic and agricultural data

inputs, and execution and calibration of the model. It was developed by Blackland Re-

search Center, in Temple, Texas of the Texas Agricultural Experiment Station, part of

the Texas A&M University System, in collaboration with Grassland Soil and Water Re-

search Lab, a USDA–ARS laboratory in Temple, Texas. The main purpose of AVSWAT

as stated by Luzio et al. (2004) is “combined assessment of nonpoint and point pollution

loading at the watershed scale.”

b. ArcGISSWAT-2003

ArcGISSWAT-2003 is an ArcGIS 8.3 extension developed at Texas A&M University

in Visual Basic 6 to manage the input/output process of SWAT. It used geodatabase data

model to store and manage the SWAT input and output data. Geodatabase object model,

also referred as data model, is discussed in the Data Models and Concept section of this

chapter. ArcGISSWAT-2003 has the capability to perform uncertainty analysis of the

model results (Valenzuela, 2003).

4. Better Assessment Science Integrating Point and NonpointSources (BASINS)

The Better Assessment Science Integrating Point and Nonpoint Sources (BASINS)

is a “multipurpose environmental analysis system for use byregional, state, and local

agencies in performing watershed- and water-quality-based studies” (USEPA, 2001).

BASINS is implemented in integrated GIS environment. BASINS contains interrelated

components to perform environmental analysis. These components are listed below as
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taken from USEPA (2001):

1. nationally derived databases with data extraction toolsand project builders

2. assessment tools (TARGET, ASSESS, and Data Mining) that address large and

small-scale characterization needs

3. utilities to facilitate data organization and evaluation

4. tools for watershed delineation

5. utilities for classifying DEMs, land use, soil type, and water quality observations

6. watershed characterization reports that facilitate compilation and output of infor-

mation on selected watersheds

7. QUAL2E, an instream water quality model

8. watershed loading and transport models, Hydrological Simulation Program - FOR-

TRAN (HSPF) and Soil and Water Assessment Tool (SWAT)

9. PLOAD, a simplified GIS based model that estimates nonpoint source pollution

(NPS) loads of pollution on an annual average basis

BASINS interface works as an extension for ArcView 3.x. It was developed to sup-

port the total daily maximum load (TMDL) program that requires the states “to develop

TMDLs for water bodies that are not meeting applicable waterquality standards by using

technology-based controls” (USEPA, 2001). BASINS incorporates many models. It has

an intricate and complicated data structure due to the fact that each model has its own

data structure. This makes it difficult to use data outside the BASINS framework, as well

as complicates the task of adding new components.
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All the models discussed here need spatial as well as temporal data as input and

how GIS cater to these needs is evident. Each hydrologic and hydraulic model stores and

manages data in either flat files having a specific format, or intheir customized databases

(like HEC-DSS). HEC-DSS allows sharing of data among HEC models only. Thus, to

share the data among different models is not straight forward. Anyone who attempts to

do so will need in-depth knowledge of every hydrologic and hydraulic model. There-

fore, an intuitive and structured format of data storage is required which is independent

of a particular model specification. This has always been envisaged by hydrologists and

environmentalists. ESRI’s Geodatabase Data Model concept,based on traditional geo-

database design, tries to achieve this daunting goal. Due tothe fact that it will be im-

practical and inefficient to make a single data model capableof storing data for all types

of models, ESRI and related organizations are working to develop “best practices” geo-

database design for various application domains (ESRI, 2004). There are various data

models categorized on the basis of industry groups, e.g., forestry, geology, ground water,

health, hydro. The next section discusses the relevant datamodels and concepts.

B. Data Models and Concept

A geodatabase data model provides a generic repository for storing geographic in-

formation implemented using a standard relational database framework. By defining and

implementing a behavior on a generic geodatabase, a wide variety of user data models

could be developed (MacDonald, 1999). Inside a geodatabase, the real world is stored as

objects in different classes and each class has associated properties and behavior. For ex-

ample, “river” is a class which defines an abstract river withproperties like length, Man-

ning’s n and bed slope. All the rivers of this world are instances of the class “river”. Fur-

ther, behavior can be implemented on this class by defining ‘subtypes’ based on length.
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An example is shown in Table 2.

TABLE 2. Subtype and Properties

Subtype Property

Short river 0 to 500 km

Medium river 501 to 2000 km

Long river 2001 km

Data models based on these concepts are described in the following sections:

1. ArcHydro

The ArcHydro data model, developed by CRWR at the University ofTexas at Austin,

provides an effective way of storing generic geospatial data for a water resources sys-

tem (Maidment, 2002). Being generic in nature, it could not store the model-specific

information, which usually has unique and complex data requirements. As mentioned

earlier, defining a behavior on ArcHydro can provide model-specific data models. The

models discussed below, evolves from the basic structure ofArcHydro data model.

2. ArcBASINS

ArcBASINS stores data for the Better Assessment Science Integrating Point and

Nonpoint Sources(BASINS) program.“ArcBASINS is a data structure that provides a

standard format for the categorization and maintenance of both spatial and tabular envi-

ronmental data” (Schneider, 2002).
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3. WRAPHydro

WRAPHydro data model stores the Water Rights Analysis Package (WRAP) spe-

cific dataset. It also uses ArcHydro data model as a referenceto meet the requirements

of WRAP model (Gopalan, 2003).

4. ArcGISSWAT

The ArcGISSWAT data model is part of ArcGISSWAT-2003 application. It inherits

the basic structure from ArcHydro data model and is further customized to meet the

specific requirement of SWAT (Valenzuela, 2003).

5. Interface Data Model for HEC-HMS

Interface Data Model for HEC-HMS is a data structure to store the contents of HEC-

HMS (Obenour et al., 2004). PrePro2004 utilizes the Interface Data Model for HEC-

HMS as the data repository and provides the tools to establish connection with HMS.

C. Summary

Avenue Scripting language can only be used to customize ArcView 2.x and 3.x.

Component Object Model (COM) is a technology that facilitatesintegration of compo-

nents developed in different languages (Microsoft, 2002),and Avenue is not compliant

with this technology. Visual Basic, being a COM-compliant language, has been chosen

by ArcGIS 8.x and later versions for customization purposes. PrePro2004 is developed

in Visual Basic for ArcGIS 8.3 and 9.0.

The data model is not a simulation model in itself as of now. The data model needs

a protocol to establish communication with the model for which it is developed. This

thesis aims at developing an interface which establishes the connection between the data
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model and HMS. The inter-operability of watershed-systemsis becoming complex. A

need to standardize the format for water quantity and quality models is strongly felt, as

standardization will make it easier to share the data. The recent efforts are being made

by San Antonio River Authority (SARA) to develop a Regional Watershed Modeling

System (RWMS) “to address issues related with water resources comprehensively and

collectively throughout the San Antonio River Basin” by making an InterLocal Agree-

ment (ILA) between the Bexar County Commissioners Court, San Antonio City Council

and SARA. This collaboration aims to achieve benefits such as (SARA, 2004)

1. using same geographical data for linking water quantity and quality models

2. development of Bexar watershed models and flood rate insurance maps

3. Medina river watershed and Medina Dam study

The tools developed for this thesis can be implemented in such scenarios.
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CHAPTER III

METHODOLOGY

The methodology is divided into preprocessing of spatial data, data management,

and post-processing of HMS output. Pre-processing includes modules to extract hydro-

graphic and topographic information from spatial data. Data management includes mod-

ules to store extracted information inside geodatabase andcreate the HMS input. The

first two parts are represented graphically in Fig. 1.

 

Geodatabase 

STREAMS 

DEM 

 PrePro2004  

HEC-HMS 

PrePro2004

FIG. 1. PrePro2004: Pre-Processing and Data Management

Post-processing includes modules to read the existing HMS model files and store it

in the geodatabase. This part of methodology is representedgraphically in Fig. 2.

A. Pre-Processor

The data required for pre-processing are Digital ElevationModel (DEM), stream

network in vector format, mask polygon, landuse polygon/raster and soil type poly-

gon/raster. Digitized stream network and mask polygon are optional. DEMs can be ob-
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FIG. 2. PrePro2004: Post-Processing

tained from United States Geological Service (USGS) website (USGS, 2004). DEMs are

available for various resolutions at no cost. Digitized stream network can be downloaded

through internet. These stream networks are assembled and distributed by many private

and government agencies. The mask polygon is a polygon whoseboundary defines the

extent of DEM to be used for preprocessing. Although, DEM data can be downloaded

based on user provided coordinates, it is rectangular in nature. Thus, the use of mask

polygon offers increased efficiency in terms of time while itutilizes only the area of in-

terest for processing. A representative mask polygon and DEM are shown in Fig. 3. It

should be noted that after applying the mask, the resulting grids are still rectangular. The

grid cells beyond the mask boundary store NoData value.

1. Watershed Delineator

In this process watershed boundaries and streams from DEMs are identified using

the eight-direction pour point algorithm (Jensen and Domingue, 1988). The inputs used

for this process are DEM, digitized stream network (optional), and mask polygon (op-
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FIG. 3. Mask and Digital Elevation Model
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tional). The digitized stream network is used to make the streams extracted from DEM

consistent with them. This is achieved by raising the elevation of cells in DEM by a

constant value for all the cells except the ones where digitized stream network overlap.

This forces the water to flow along the digitized stream path.Mask polygon, as explained

earlier, is used to obtain the clipped DEM that will be used for further processing. The

DEM is then processed to obtain a flow direction grid. Based on the D8 algorithm, each

cell flows to its neighboring cell which has steepest slope along eight directions. Among

the eight flow directions, four are along the edges and four are along the corners of a cell.

Based on the Fig. 4, each cell in the flow direction grid stores one of the eight direction

code values.

1

28
4

16

32
64

128

FIG. 4. Flow Direction Codes

After the flow direction grid is obtained, the next step is to determine the flow accu-

mulation grid. In the flow accumulation grid, each cell stores the value for the number
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of cells flowing to it. This value also represents the area draining to a particular cell.

The drainage area for a cell is obtained by multiplying the cell value by the area of cell.

Note that for raster grid format, each cell is a square with equal cell size. After the flow

accumulation grid is obtained, the user is prompted to provide a threshold value, in terms

of number of cells, to define streams. All the cells in flow accumulation grid that have

value greater than the threshold value are extracted to obtain the stream definition grid.

The stream definition grid has cells with values either 1 or NoData. NoData signifies that

a particular cell does not contain any value. Using the stream definition grid, a stream

link grid is obtained. The stream link grid stores differentlink in the stream network.

At every intersection of streams in stream definition grid, anew stream link is created.

Once the stream link grid is obtained, an Outlet grid is created by extracting the last cell

of each stream link. The stream link grid and outlet grid are converted to vector format

from raster format. Two shapefiles, Reach and Outlet, are obtained. {Reach} is a poly-

line shapefile of streams having an attribute ‘GridCode’.{Outlet} is a point shapefile

of outlets having an attribute GridCode. The GridCode attribute of streams and outlets

relates them. It should be noted that outlet shapefile is added to the ArcMap with layer

name MonitoringPoint.{Outlet} shapefile is also attributed with projected X and Y co-

ordinates, latitude, longitude, Type, and SBMerged. The field Type stores Outlet for all

the features. The field SBMerged will be used when the subbasins are merged in later

steps.

Sometimes, the user may be interested in particular streamsthat are not captured by

the provided threshold value. These streams have a lesser flow accumulation value than

threshold value. If we decrease the threshold value to capture the stream of interest, we

will end up with a dense stream network with unwanted streams. To overcome this limita-

tion, a tool to add streams by defining the headwater of streaminteractively on the map is

provided. The user will use PrePro2004 tools to create a point on the map representing the
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most upstream point of headwater to be added. This point is added to the{Outlet} shape-

file with Type StrPnt. The stream link grid and outlet grid arere-created with the added

headwater. These grids are again vectorized. After vectorization, two shapefiles IUReach

and IUOutlet are created. They have the same attributes as{Reach} and{Outlet} shape-

file. It should be noted that{IUOultet} do not have StrPnt.{IUReach} and{IUOutlet}

are created only when user adds new stream. After adding the new streams, the ArcMap

will still have the layer named MonitoringPoint but now the data source to this layer is

the shapefile IUOutlet.

Once the stream lines and outlet points are obtained, user can add other points of

interest, namely outlet, inlet, and reservoir. Outlet can represent a flow change location

or a monitoring point. Inlet can represent a point of inflow tothe study area. Likewise,

reservoirs are multi-purpose structures which either already exist or are added for future

planning. The user can add these point interactively on the map. All these points are

snapped to the nearest stream while added by the user. The added points are stored in

{IUOutlet} shapefile. They are not stored in{Outlet} shapefile since we do not want

to lose the already added StrPnt. The added reservoirs, inlets, and outlets are attributed

with Type Rsv, UDInlet, and UDOutlet, respectively. Once theuser-defined points are

added, watershed delineation is performed. For watershed delineation, most downstream

point needs to be selected as the outlet of the basin. All the streams and points above the

selected outlet will be automatically used for the delineation. The delineated watershed

grid is obtained and is vectorized to get watershed polygons. These watershed polygons

are merged together to get the basin polygon representing the boundary of overall basin.

Four output shapefiles are obtained from above mentioned processing steps: stream

polyline (IUReach), points representing outlet, inlet or reservoir (IUOutlet), watershed

polygon (IUWatershed), and basin polygon (Basin). The basinpolygon is created by

merging the polygons in watershed shapefile. The shapefiles IUReach, IUOutlet, and
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IUWatershed have one-to-one relationship using attributeGridCode. GridCode helps in

identifying the stream and outlet associated to a particular watershed. This also empha-

sizes that at this point we have a unique stream and a unique outlet for a watershed.

From these output files, we create separate output files for different elements of HMS

basin file. HMS basin file has seven elements, namely subbasin, reach, inlet, junction,

reservoir, sink, and junction. In this work we have created subbasin, reach, inlet, junc-

tion, and reservoir elements. The user can select more than one outlet as the downstream

point for watershed delineation using PrePro2004. Every outlet upstream to the selected

outlets will be a part of the delineated watershed. The most downstream outlets should

be translated as sink in the HMS model. Since HMS can only one sink, PrePro2004

does not create the sink automatically. Therefore, user should define the sink for their

model in HMS interface itself. Defining diversions from HMS interface is easier than

trying to create one using GIS for all the practical purposes. The subbasin and reach

shapefiles, IUWatershed and IUOutlet, are already created.To create inlet and reservoir

shapefiles, the points with Type Reservoir and Inlet are exported from shapefile IUOut-

let. The creation of junctions need some processing. Junctions in HMS represent a point

of intersection of two or more streams while outlet points obtained above represent the

end point of each stream link (Fig. 5). In order to obtain junctions, the outlet points are

moved one cell downward in the direction of flow, thus resulting in two coinciding junc-

tion points. One of the junction points is arbitrarily deleted. Junctions are also obtained

at user-defined outlets. It should be noted that at user-defined points, there is only one

junction.

The junctions created are attributed with the subbasins upstream to it and subbasin

downstream to it. This attribution facilitates in establishing the topology explained fur-

ther in the document. The junctions, inlets, reservoirs, streams, and subbasin have a field

in their attribute table named HMSCode. The field HMSCode stores the unique global
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FIG. 5. Difference Between Watershed Outlet and HMS Junction

identifier for each element in the study area.

Further, the user may not be interested in working with smaller subbasins, so tools

are provided to merge the subbasins. Before merging the watershed, the number of outlets

is equal to the number of stream links. When two subbasins are merged, the resulting

subbasin has more than one stream and only one outlet. After merging, the number of

outlets become more then the number of streams. It is crucialto identify the watershed to

which a stream belongs in order to develop a topologically correct stream and watershed

network. To achieve this goal a field WshCode is added to the attribute table of streams

shapefile. WshCode stores the GridCode of watershed to which a stream belongs. For

two subbasins to merge, they should satisfy one of the following conditions:

1. The subbasins must have a common junction.
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2. One of the subbasins is flowing to the other subbasin.

3. If one of the subbasin flows to another one, the upstream subbasin should not be

having reservoir as its outlet.

4. Only two subbasins can be merged at a time.

Once the watersheds are merged, various parameters are calculated for streams and

watershed. The parameters calculated for each subbasin arearea, length and slope of

longest flow-path, elevation of most upstream and downstream point of longest flow-

path, length of centroidal flow path and average subbasin slope. Flow path is the path

taken by drop of water from any point in the subbasin to the subbasin outlet. Flow length

is the length of flow path along the flow direction. Longest flowpath is the flow path

taken by a drop of water from the farthest point in the subbasin, located at subbasin

boundary, to the subbasin outlet. The procedure to determine the longest flow path is

explained in Olivera (2001). The slope of longest flow path isobtained as division of

the difference in elevation of the end points by the length ofthe longest flow path. Also

the slope of longest flow path between the points located at 10% and 85% distance from

starting point of longest flow path is obtained. The centroidal flow path length is obtained

by projecting the centroid of subbasin onto the longest flow path. This is shown in Fig. 6.

This projection gives a point on the longest flow path . The length from this projected

point to the watershed outlet, along the longest flow path, represents the centroidal flow

path length. The parameters calculated for streams are the length, elevation of most

upstream point of stream and elevation of most downstream point of stream.

The topology is developed to facilitate the flow of water through the network of

stream, junctions and subbasins till it reaches the most downstream point of the study

area. To establish the topology we need to know, for each element, the downstream

element. Like the stream(1) flows to junction(1), junction(1) flows to stream(2), sub-
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basin(1) flows to junction(1) and so on. This is done by using spatial querying along with

fields GridCode and WshCode. A field DownCode is added to table of every elements’

shapefile. This DownCode field stores the HMSCode of element downstream to it. The

junctions are used to identify the streams, spatially, on which they lie. The junctions are

attributed with HMSCode of identified streams in the field DownCode. Similarly, the

downstream elements for inlets and reservoirs are identified. To identify the downstream

element for a stream, we loop through all the junctions. The downstream elements to the

junction, already determined stream to which it drains, aretraced upstream. The resultant

stream thus drains to this junction. The streams DownCode field is attributed with the

HMSCode of the junction. To identify the downstream element of subbasins, we need

to identify all the streams that belong to the subbasin. Thisis achieved by querying the

streams having WshCode similar to GridCode of subbasins. Amongall the streams be-

longing to a subbasin, the most downstream stream is identified. The DownCode element

to the most downstream stream is the downstream element for subbasin. This process is

repeated for all the subbasins in the study area. Thus, the fields DownCode and HM-

SCode can now be used to trace the stream and watershed network.

Fig. 7 shows the various inputs to and outputs from the watershed delineator. The in-

puts are DEM, threshold value for stream definition, mask polygon, and digitized stream

network. The outputs are DEM after embedding digitized stream network, called Burned

DEM, Filled DEM, Flow direction grid, Flow Accumulation Grid, Stream and outlet

grids, stream and outlet shapefile, watershed polygon.
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2. Curve Number Calculation

In this process SCS curve number (CN) for a watershed is calculated. HMS needs

CNs for its SCS CN runoff method and SCS Unit Hydrograph (UH) transform method.

The CN for a watershed is estimated based on land use, soil typeand impervious cover

percentage. Thus, inputs for this process are land use polygons, soil type polygons, wa-

tershed polygons and a lookup table. The lookup table has theCN’s for each hydrologic

soil group corresponding to different land uses. A sample lookup table is provided in the

Appendix A.

The soils in United States are placed in four hydrologic soilgroups A, B, C, and D.

The soil groups are classified based on the runoff potential,where A has the lowest runoff

potential and D has highest runoff potential. It means that Ahas the highest infiltration

rate and D has the lowest infiltration rate. The soils data obtained has an associated table

which stores the percentage of A, B, C, and D hydrologic soil group for different types

of soils (NRCS, 2003). A curve number for each subbasin is calculated based on the land

use and the percentage of hydrologic soil groups. A composite curve number is calculated

for lumped basin model based on area-weighted average. For gridded modeling each cell

has a curve number. The CN for each polygon, resulting from intersection of subbasin

polygons, landuse polygons and soil type polygons, is calculated as:

CNs = (A% × CNA + B% × CNB + C% × CNC + D% × CND)/100 (3.1)

CNb =
CNs − ICs

(1 − ICs/100)
(3.2)

where,

CNs - the curve number,

A% - the percentage of soil group A in the soil

B% - the percentage of soil group B in the soil
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C% - the percentage of soil group C in the soil

D% - the percentage of soil group D in the soil

CNA - the curve number for soil group A for a particular landuse

CNB - the curve number for soil group B for a particular landuse

CNC - the curve number for soil group C for a particular landuse

CND - the curve number for soil group D for a particular landuse

ICs - the impervious cover percentage for subbasin,

CNb - the base curve number for zero percent impervious cover.

The area-weighted curve number and impervious cover percentage for each subbasin

are calculated as:

CNAveri
=

∑
i[CNi × Ai]∑

i Ai

(3.3)

CNAverbi
=

∑
i[CNbi

× Ai]∑
i Ai

(3.4)

ICAveri
=

∑
i[ICi × Ai]∑

i Ai

(3.5)

where,

i - subbasin number,

CNAveri
- the average curve number for subbasini,

CNi - theCNs for subbasini,

Ai - the area of subbasini,

CNAverbi
- the average base curve number for subbasini,

CNbi
- theCNb for subbasini,

ICAveri
- the average impervious cover percentage for subbasini,
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ICi - theICs for subbasini.

To modify the curve number, which is required for evaluationof different modeling

scenarios as well as future development, the user can modifythe land use, soil type

and/or impervious cover percentage. The curve numbers after changing the impervious

cover are obtained from the average base curve number for thesubbasin:

CNIC =
IC

100
× 100 + (1 −

IC

100
) × CNAverb

(3.6)

where,

IC - the new impervious cover percentage,

CNIC - the new curve number corresponding to IC.

The curve number calculation can be performed using either shapefiles or ESRI

raster grids. The format of lookup table is the same for both the options. For using

raster grids, one additional table is needed, which stores the percentages of hydrologic

soil groups for each soil present in the region. The format for both the tables is described

in Appendix A.

3. Parameter Calculation for Mod-Clark Transform Method

As mentioned earlier, HMS supports lumped parameter models, as well as, dis-

tributed parameter models. A distributed model is able to capture the spatial variability

of rainfall better then a lumped-parameter model. HMS uses ModClark transform method

to support the distributed modeling. To use this option in HMS, we need a gridded rep-

resentation of watershed along with the length of travel path from the center of each
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grid cell to watershed outlet. All this information is stored in the grid-cell parameter file

containing the fields described in Table 3.

TABLE 3. Columns in Grid Parameter File

Cell x-coordinate

Cell y-coordinate

Travel distance from center of grid cell to watershed outlet

Area of grid cell

SCS CN for grid cell (optional)

PrePro2004 creates this file by intersecting the grid cell polygons and the water-

shed polygons, and further processing the data to obtain thetravel length from each grid

cells’ center to the watershed outlet. The input for this procedure is a polygon shapefile

of grid cells. The output grid cells can be created to have x- and y-coordinates corre-

sponding to either Hydrologic Rainfall Analysis Project (HRAP) grid format or HEC’s

Soil Hydrologic Grid (SHG) format. The HRAP coordinates are calculated based on the

information gathered from National Weather Service website (NWS, 2002) and SHG co-

ordinate based on the information from HEC-HMS (2001). Readeris referred to NWS

website to read more about HRAP and HEC website to read more about SHG coordinate

systems. A shapefile [GridCellParam] is created as shown in Fig. 8. It is used to generate

the input file for HMS. The creation of input file from the shapefile is described in Data

Processing section (section B) of this chapter. In the attribute table of GridCellParam

shapefile Name field stores a unique identifier for each grid cell, Area stores the area for

each grid
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Legend

Grid  Cel l

FIG. 8. GridCellParam Shapefile and Its Attribute Table.
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cell, HMSCode field stores the identifier for watershed to which a grid cell belongs and

GCFlowL field stores the travel distance from center of grid cell to the watershed outlet.

A grid-cell parameter text file is created in the later steps which stores data listed in

table 3 for each grid cell in the study area.

4. Gage-Weight Calculation Based on Thiessen Polygon

HMS needs precipitation data to model the watershed response. This precipitation

data can either be observed rainfall from a historical eventor frequency-based hypothet-

ical storm. The observed rainfall from a historical event can either be obtained from a

rainfall-measuring gage or from a radar. The use of radar rainfall data was discussed

in previous section. In this section we will discuss the observed rainfall obtained from

gages. The data obtained from field-monitoring gives the precipitation depth at the loca-

tion of measuring gage. For lumped-parameter models, we need rainfall depths averaged

for each watershed.

The equation 3.7, taken from HEC-HMS (2001), calculates the watershed average

precipitation depth.

PMAP =

∑
i{wi

∑
t pi(t)}∑

i wi

(3.7)

where,

PMAP - total storm mean areal precipitation (MAP) over the watershed,

pi(t) - precipitation depth measured at timet at gagei,

wi - weighting factor assigned to gage/observationi.

One of the methods to calculate weighing factorswi is area-based weighing scheme

using thiessen polygons. PrePro2004 can calculate these weighing factors based on the

thiessen polygons. The inputs required are watershed polygons and gage points. Based
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on the location of gage points, thiessen polygons are created and clipped to the boundary

of the basin. “Thiessen polygons are generated from a set of points, defined by the

perpendicular bisectors of the lines between all points anddrawn so that each polygon

bounds the region that is closer to one point than to any adjacent point and the length

of the edges that form Thiessen polygons is equal” (ESRI, 2004). Fig. 9 shows the

shapefile GageWeights obtained from intersection of the theiessen polygons of gages

and the subbasin, and Fig. 10 shows the attribute table of theshapefile GageWeights.

Also, the gage point shapefile provided by the user is stored as HMSGages shapefile at

the project output location.

Legend

Gage Po in t

Thiessen Po lygon

Watershed

FIG. 9. GageWeights Shapefile.

The fields shown in the attribute table of Fig. 10 are as follows:

GageCodestores the unique identifier for each gage and is taken from the gage point
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shapefile provided by user,

ThPAreastores the area of polygons resulted from intersecting thiessen polygons

and watershed polygons,

Areastores the area of watershed polygons,

GageWtstores the area-weighted value calculated using equation.3.8,

HMSCodestores the unique identifier for watershed polygons.

FIG. 10. Attributes of GageWeights Shapefile.

The gage weights are calculated based on the equation given below:

GWis =
apis

As

(3.8)
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where,

GWis - the gage weight of gagei for subbasins,

apis - the area of polygon resulted from intersection of thiessenpolygon

for gagei and subbasin polygons,

As - the area of subbasins.

B. Data Processing

In this process, the output obtained from pre-processing ofdigital data is read and

stored in the HMS geodatabases. The input ASCII text files are created, which are used

as input to HMS for setting up a hydrologic model. Geodatabase can either be personal

or multiuser. As mentioned earlier, geodatabase can work across a range of Relational

DataBase Management System. Table 4 lists the different RDBMS architectures compat-

ible with geodatabase type.

TABLE 4. Comparison of Personal and Multiuser Geodatabases. (Source: ESRI, 2004)

Geodatabase type RDBMS

Personal geodatabase Microsoft Jet Engine (Access)

Multiuser, versioned - Oracle

geodatabase - Oracle with Spatial or Locator

- IBM DB2

- IBM Informix

- Microsoft SQL Server

In this thesis we have used personal geodatabases with underlying RDBMS as MS
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Access. The geodatabase data models emulate the input and output structure of HMS,

thus allowing communication between them. The factors listed below lead to inclusion

of two geodatabases in HMS IDM (Obenour et al., 2004):

1. Provide a database capable of storing all model data, so that the data may be queried

and retrieved efficiently.

2. Store data in a manner so that they are readily transferable between the geodatabase

format and the format required by the model.

3. Store the model’s spatial data in a manner that can be easily viewed in ArcMap.

4. Store data in a format compatible with the Arc Hydro namingconventions.

5. Provide a link between the IDM spatial data and the associated Arc Hydro spatial

data, thus providing a connection between the IDM and Arc Hydro geodatabases.

6. Provide a data storage structure that is intuitive to the user.

7. Minimize the size of the geodatabase (in terms of disk space).

The Project geodatabase stores the data pertaining to HMS project as a whole. The

project geodatabase is a repository to store general project set-up information, scenario

management information, recorded time series data, and meteorological data. The Basin

geodatabase stores the data pertaining to HMS basin files. The basin geodatabase is a

repository to store the subbasin parameters, routing parameters, and time series results

data. It is recommended to have a unique basin geodatabase for every basin file (Obenour

et al., 2004).

The HMS geodatabases, basin and project, are shown in Fig. 11. In the basin geo-

database, the spatial elements like subbasin, reaches, junctions, reservoirs, diversions,
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FIG. 11. The Basin and Project Geodatabases
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sources, and sinks are stored in feature classes. There is a separate table to store the basin

parameters including lossrate, transform, baseflow, and routing data. For example, each

lossrate method (Deficit + Constant, Green And Ampt, Gridded SCS, Gridded SMA,

Initial + Constant, SCS, SMA) has a separate table.

In the Project geodatabase, the general set-up informationand scenario management

data is stored in tables. These tables are ProjectBasinGeoPaths, ProjectHMSHeader,

ProjectHMSIndex, ProjectHMSPData, ProjectRuns, ProjectControls, and SMAUnits.

The spatial elements like precipitation gages and precipitation grid are stored in feature

classes HMSGage and HMSGrid located inside HMSProjectFeatures feature dataset; not

shown in Fig. 11.

In HEC-HMS, the time series and paired data is stored in HEC-DSS(Data Storage

System) binary format. The DSS stores the data in blocks along with its metadata. The

metadata includes the ‘pathname’ which is a unique identifier and description of a data

block. The example pathname shown below is having the project name, the element, type

of data, the time period of the data block, the time step and description.

Example Pathname: /GREEN RIVER/GLENFIR/FLOW/01APR1992 -

01MAY1992/1HOUR/EDIT/

In IDM, the DSS structure is translated into set of tables. DSSTSCatalog stores all

of the metadata and DSSTimeSeries stores all of the time series data. The two tables are

related to each other through the long integer field DSSTSID.Similarly, DSSPDCatalog

stores all of the metadata and DSSPairedData stores all the paired value data. The two

tables are related to each other through the long integer field DSSPDID.
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1. Exporting Output to Geodatabases

The output files, shapefiles and raster grids, obtained from pre-processing as shown

in Fig. 12, are transferred to the basin geodatabase and the project geodatabase.

FIG. 12. The Output Files Obtained after Pre-Processing Step

a. Basin Geodatabase

In this section we will discuss the data that is exported to the basin geodatabase.

The output shapefiles are exported to corresponding featureclasses in feature dataset

‘HMSBasinFeatures’ inside the geodatabase as shown in Table5.
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TABLE 5. Shapefile and Feature Class Mapping

Shapefile Feature class

IUWatershed HMSSubbasin

Reach HMSReach

JCT HMSJunction

RES HMSReservoir

INL HMSSource

During the pre-processing, the hydrologic information is extracted from geospatial

data after terrain analysis. This extracted information includes the subbasin parameters

and reach parameters. The subbasin parameters obtained arethe length of the longest

flow path, the upstream and downstream elevation of the longest flow path, the slope

of the longest flow path for its complete length, the slope of the longest flow path for

its length between 10% and 85% (the length between the point located at a distance 0.1

times the total length from the starting point and point located at a distance 0.85 times the

total length from the starting point of the longest flow path), the centroidal flow length,

the elevation of subbasin centroid, the latitude and longitude of subbasin centroid and

watershed slope. The reach parameters obtained are the upstream and downstream eleva-

tion of river reach and the slope of river reach. Since there are no existing feature classes

or tables in the basin geodatabase to store the above obtained information, two tables,

〈SubbasinParam〉 and 〈ReachParam〉, are created in the geodatabase to accommodate

this additional information.SubbasinParamstores all the information about subbasins

and is related to{HMSSubbasin} by values in the field GridCode.ReachParamstores all

the information about reaches and is related to{HMSReach} by values in the field Grid-

Code. This information is crucial to calculate parameters for HMS which is discussed
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later. Figs. 13 and 14 shows part of the〈SubbasinParam〉 and〈ReachParam〉 attribute

tables, respectively.

FIG. 13. SubbasinParam Stores the Information Pertaining to Subbasins

FIG. 14. ReachParam Stores the Information Pertaining to Reaches

The tables〈GridcellHeader〉 and〈Gridcell〉 are populated with the parameters cal-

culated for ModClark option of HMS (Fig. 15).
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(a) GridCellHeader table

(b) GridCell table

FIG. 15. Tables Populated with Calculated Grid Cell Parameters
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b. Project Geodatabase

In this process the data generated during gage-weight calculation using thiessen

polygons and associated [HMSGages] shapefile are exported to the project geodatabase.

The [HMSGages] shapefile is used to populate the{HMSGage} feature class inside ‘HM-

SProjectFeatures’ feature dataset. The gage-weights are stored in the [GageWeights]

shapefile shown in Fig. 12 which are transferred to the tablesMeteorologicalUserWeigh-

tedSubbasin and MeteorologicalUserWeightedGage. These tables are related to each

other through a text field GageCode. Also GageCode field relatesthe{HMSGage} fea-

ture class with the table〈MeteorologicalUserWeightedGage〉.

2. Processing Data in Geodatabase

HMS has SCS Unit Hydrograph as one of the transform methods which needs the

basin lag in time units. The basin lag is defined by Wurbs and James (2002) as “the

time between the center of mass of the rainfall and peak of thehydrograph”. PrePro2004

calculates the basin lag time using the National Resource Conservation Service (NRCS,

formerly known as SCS) lag equation. The equation in metric units is given in 3.9.

tL = 0.6 ∗
100l0.8(1000 − 9CN)0.7

1900CN0.7S0.5
(3.9)

where,tL = the basin lag time in hours,l = the length of longest flow path,CN = the

curve number for the subbasin, andS = the average subbasin slope (%).l, CN , andS are

calculated during the pre-processing step and are retrieved from 〈SubbasinParam〉 table

in the basin geodatabase.

The table〈TransformSCS〉 is populated with the calculated basin lag. The table

〈LossrateSCS〉 is populated with curve numbers and impervious cover percentages. This

module is created as a separate executable file for future expansions and enhancements.
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Figs. 16 and 17 shows the tables with calculated parameters.

FIG. 16. LossRateSCS Table
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FIG. 17. TransformSCS Table
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3. Create HMS Input

The HMS input files are created from the data in the geodatabases. The geodatabase

can be populated in two ways. The first way is after processingthe geospatial information

which is already explained. The second way is after post-processing in which an existing

HMS model is transferred to geodatabase. This is explained later in the document.

The basin geodatabase is used to create the files required forbasin component of

the HMS. The following ASCII text files are created: a basin file, a background map file

and a grid cell parameter file for ModClark transform option ofHMS. These text files

can be imported in HMS to set up a hydrologic model. The arrowsshown from Basin

Geodatabase to Typical Basin File in Fig. 18 shows the features classes and tables used

for the creation of the basin file. The table HMSBasinHeader is used to create the header

of basin text file. The blocks for the subbasins in the basin text file are created from the

information inside HMSSubbasin feature class and related tables of lossrate, transform,

and baseflow methods. Recall that the tables are related to feature class with a text field

HMSCode. The blocks for the reaches in basin text file are created from the informa-

tion inside HMSReach feature class and related routing method tables. The blocks for

junctions, sources, reservoirs, diversions and sinks (notall are shown in Fig. 18) in the

basin text file are created from the information inside the HMSJunction, HMSSource,

HMSReservoir, HMSDiversion, and HMSSink feature class, respectively.
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Basin: Salado Creek

     Description: Basin model created with PrePro2004

     Last Modified Date: 2 November 2004

     Last Modified Time: 07:19:31

     Version: 2.2.2

     Default DSS File Name: C:\hmsproj\Basin01\Basin01.dss

     Unit System: English

     Map File: D:\Output\BasinMap.map

End:

Subbasin: R00

     Canvas X: 1213771.236

     Canvas Y: 914174.587

     Label X: 16

     Label Y: 0

     Area: 0.06

     Downstream: J0

     LossRate: SCS

     Percent Impervious Area: 12

     Curve Number: 69

     Initial Abstraction: 0

     Transform: SCS

     Lag: 4.82931399658628

     Baseflow: None

End:

Reach: R1340

     Canvas X: 1208526.089

     Canvas Y: 920048.056

     From Canvas X: 1208166.562

     From Canvas Y: 920064.804

     Label X: 16

     Label Y: 0

     Downstream: J1340

     Route: Muskingum

     Muskingum Steps: 1

End:

Junction: Outlet

     Canvas X: 581041.263

     Canvas Y: 4170346.363

     Label X: 16

     Label Y: 0

     Observed Hydrograph Gage: Out

End:

Source: SRC20

     Canvas X: 619203.742

     Canvas Y: 3364047.509

     Label X: 

     Label Y: 

     DownStream: R180

End: 

Reservoir: RES40

     Canvas X: 612954

     Canvas Y: 3366008

     Label X: 

     Label Y: 

     DownStream: R90

End: 

Typical Basin File Basin Geodatabase

FIG. 18. Mapping between Basin File and Basin Geodatabase
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The background map file is created from the stream polylines and subbasin bound-

aries. The stream polylines and subbasin boundaries are extracted from features stored in

HMSReach and HMSSubbasin feature class, respectively. Thisfile is only for visualiza-

tion purposes. An example map text file is shown in Fig. 19.

MapGeo:  BoundaryMap

MapSegment:  closed

    1147980, 832139

    1147975, 832736

  . .

 . .

MANY LINES ARE SKIPPED

 . .

 . .

MapSegment:  closed

    1153280, 816975

    1153280, 816984

  . .

 . .

MANY LINES ARE SKIPPED

  . .

 . .

MapSegment:  open

    1155838, 801724

    1155954, 801610

  . .

 . .

MANY LINES ARE SKIPPED

  . .

 . .

MapSegment:  open

    1154478, 796024

    1154450, 795995

  . .

 . .

MANY LINES ARE SKIPPED

  . .

 . .

    1151875, 791769

    1151856, 791749

FIG. 19. The Background Map File

The MapSegment:Closed represents a subbasin and listed are the x and y coordinates

below it to create a subbasin polygon. The MapSegment:Open represents a reach and

listed are the x and y coordinates below it to create a reach line.

A grid cell parameter file is created from the information stored in the tables Grid-

CellHeader and GridCell. The columns of the grid cell parameter file are listed in Table 3.
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This file is required when ModClark method is used for distributed-parameter watershed

modeling in HMS. An example grid cell text file is shown in Fig.20.

PARAMETER ORDER: XCoord YCoord TravelLength Area SCSCN

SUBBASIN:  R980980

GRIDCELL:  -34935  11315  472.000000  5794.986450  17

GRIDCELL:  -34952  11319  473.000000  52564.423674  17

GRIDCELL:  -34972  11324  474.000000  5080.047274  17

GRIDCELL:  -34969  11325  496.000000  49299.132987  17

GRIDCELL:  -34932  11315  499.000000  123846.307771  17

GRIDCELL:  -34952  11321  500.000000  287677.258340  17

GRIDCELL:  -34930  11316  516.000000  27568.729751  17

GRIDCELL:  -34946  11321  530.000000  72869.114916  17

END:

 . . . . . . 

 . . . . . . 

 . . . . . . 

  MANY LINES ARE SKIPPED

 . . . . . . 

 . . . . . . 

 . . . . . . 

SUBBASIN:  R18801880

GRIDCELL:  -34977  11326  475.000000  10424.253459  58

GRIDCELL:  -34965  11326  497.000000  89.583040  58

SUBBASIN:  R120120

GRIDCELL:  -34814  11331  1559.000000  47664.680294  62

GRIDCELL:  -34824  11334  1560.000000  40865.562431  62

GRIDCELL:  -34816  11333  1574.000000  27884.519847  62

GRIDCELL:  -34823  11335  1575.000000  52985.237744  62

END:

FIG. 20. The Grid Cell File

The first line stores the order of parameters in the text file. They are typically the x-

coordinate of cell center, the y-coordinate of cell center,the travel time from cell center

to watershed outlet, and the area of cell. The last parameteris optional and can either

be SCS curve number or SMA unit. The last parameter is determined from the lossrate

method used.

The meteorological file is created from the data stored in theProject geodatabase.

Additional files that can be created are project file (with extension .hms), gage file (with

extension .gage), paired data file (with extension .pdata) and soil moisture accounting unit

file (with extension .sma). The mapping between the text filesand the project geodatabase

is shown in Fig. 21.
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File with extention .hms

File with extention .pdata
File with extention .run
File with extention .sma

File with extention .gage

FIG. 21. Mapping Between HMS Files and Project Geodatabase
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The table MeteorologicalHeader is used to create the header block of meteorolog-

ical text file (Fig. 21). Appropriate precipitation method table is used based on the pre-

cipitation method stored in MeteorologicalHeader table. The example meteorological

text file used Weighted Gages as the precipitation method. Thus the further informa-

tion for text file is read from tables MeteorologicalUserWeightedGage and Meteorolog-

ical UserWeightedSubbasin.

The file with extension .gage is created from the data stored in feature class HMS-

Gage. This file stores the information about the gages in the HMS model. The file with

extension .hms is created from the information stored in tables ProjectBasinGeoPaths,

ProjectHMSHeader, ProjectHMSIndex, and ProjectControls. This file stores the project

set-up information for the HMS model. The file with extension.pdata is created from the

information stored in table ProjectHMSPData. This file stores the pathnames of paired

value data in DSS file corresponding to different elements inthe basin model. The file

with extension .run is created from the information stored in table ProjectRuns. This

files stores the scenario management information for the HMSmodel. The file with ex-

tension .smu is created from the information stored in tableSMAUnits. This file stores

the information for Soil Moisture Accounting lossrate method of the HMS model.

The DSS file is created from the data stored in tables DSSTSCatalog, DSSTimerSeries,

DSSPDCatalog, and DSSPairedData.
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C. Post-Processor

Post-processor reads the HMS output and input data, and stores it in an appropriate

location either in basin geodatabase or project geodatabase. The HMS output is stored in

HEC-DSS file format. PrePro2004 provides the interface that allows query of the DSS

data and exportation to the geodatabase. The DSS file is a binary format file, thus the

data inside it can only be accessed through HEC software. Thecommunication between

DSS and geodatabase is established through a DLL hlib42.dllcreated by HEC. hlib42.dll

exposes it functions to be used by other programming language like Visual Basic. The

discussion of the functionality of this dll is beyond the scope of this thesis. The reader is

referred to HecLIB (1991) to read about the exposed functions and their implementation.

As mentioned earlier except the time series and paired valuedata, HMS stores all

the other information in text files. Figs. 18 and 21 shows the relationship to create the

text files from the data inside the geodatabases. Similar relationship is followed to store

the data inside the geodatabases from the text files.

In the post-processor, modules are created to export the existing HMS model to

geodatabases. All the text files related to basin model, meteorological model and control

model are read, and the data is stored at appropriate locations in geodatabases. It should

be noted that after transferring the text files, geodatabases do not have shapes as HMS

does not store the geographic data of various elements of basin model. If we use a

preprocessor like HEC-GeoHMS to create HMS input, we will getvarious shapefiles.

The features from these shapefiles can be exported to populate feature classes inside

‘HMSBasinFeatures’ dataset with the shape information. Thegage locations shapefile

can be used to transfer shape to HMSGage feature class in the Project geodatabase. The

interface shown in Fig. 22 is used to accomplish this transfer.

The left side of the interface asks the user to provide the source data information.
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FIG. 22. Interface to Transfer Shapes Data Inside Geodatabases
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The right side of the interface shows the target data information. The user cannot edit

this information. The source data is mapped to target data based on the field specified by

user in source data match field and HMSCode field in the target data. It should be noted

that HMSCode is a text field, therefore, the matching field of source data should also be

a text field. Also, only the features in the source data that have an existing HMSCode

value in the target data will participate in the shape transfer process. The interface can

transfer only the shapes information and will not transfer any other information stored in

the attribute table of the source data.
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CHAPTER IV

APPLICATION, RESULTS AND DISCUSSIONS

A case study is presented to illustrate the methodology explained in chapter III. The

Salado Creek (Fig. 23) is located in Upper San Antonio watershed which is a part of San

Antonio River Basin. The input data is obtained from differentsources and is processed

using PrePro2004 interface to create input for HEC-HMS. PrePro2004 is also used to

store existing HMS model in geodatabases and reproduce the HMS model. The existing

HMS model was obtained from PBS&J.

FIG. 23. Aerial View of Salado Creek (Source:www.sara-tx.org)
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A. Description of Study Area

The Salado Creek watershed is located in Bexar County of South Central Texas

(Fig. 24). The watershed has an approximate drainage area of222 square miles. The

Salado Creek watershed is part of the San Antonio River Basin that has an approximate

drainage are of 4,180 square miles. San Antonio city (Fig. 24) is the most densely popu-

lated area of the basin. The city is expanding due to continuous residential, commercial

and industrial development.

San Antonio covers most of the Bexar County as shown in Fig. 24. The lower

portion of Salado Creek watershed covers the San Antonio metropolitan area, which is

highly urbanized. Salado Creek starts from north Bexar County and joins San Antonio

river few miles south of Loop 410 after traversing a distanceof approximately 40 miles.

B. Data Description

The input data is gathered from different websites. The dataobtained are Digital El-

evation Model, digitized stream network, land use data and soil type data. The following

sections describe each of them in detail.

1. Digital Elevation Model

The stream and watershed network is obtained from a 10-meterDEM. The DEM

data is donwloaded from USGS website (http://seamless.usgs.gov/viewer.html). The site

provides a number of geospatial datasets. National Elevation Data (NED) is downloaded

as a rectangle to cover the study area. The data has a resolution of 1/3 Arc Second (ap-

proximately 10m). USGS developed NED to provide data in seamless form by merging

high resolution and best-quality available DEM data (USGS,2004). The downloaded

data has the following properties:
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TEXAS BEXAR
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      CREEK

FIG. 24. Salado Creek Watershed
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Projection =⇒ Geographic

Horizontal Datum =⇒ North American Datum 1983 (NAD83)

Vertical Datum =⇒ North American Vertical Datum 1988 (NAVD88)

Horizontal Units =⇒ Decimal Degrees

Vertical Units =⇒ Meters

The data is obtained in ArcGRID format which can be directly used in ArcGIS

applications. ArcGRID format is also referred as ESRI GRID format. The DEM is

projected to Universal Transverse Mercator (UTM) Zone 14 using ArcToolBox, part of

ArcGIS suite of applications. The resulting DEM is shown in Fig. 25.

2. Reach

Reach data or digitized stream network data is required to make the streams delin-

eated from DEM consistent with the real streams. For this purpose, the digitized stream

network is obtained from National Hydrography Dataset (NHD). NHD data is developed

by integrating USGS Digital Line Graph (DLG) hydrography data with reach-related in-

formation from EPA Reach File Version 3 (RF3) (NHD, 2004). The data is downloaded in

NHDinGeo format. This format provides geodatabase containing various feature classes

and tables (Fig. 26).
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High : 606.468

Low : 95.0339
0 12,500 25,000 37,500 50,0006,250

Meters

FIG. 25. 10m DEM for Salado Creek
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FIG. 26. NHD in Geodatabase Format (NHDinGeo)

NHD data contains information about surface water featuressuch as lakes, ponds,

streams, rivers, springs, reservoirs and wells. The feature class NHDFlowline is exported

as new shapefile. The exported shapefile also share the same spatial reference properties

as NHDFlowline. These properties are:

The data is re-projected to UTM Zone 14 in order to match the horizontal datum of

the projected DEM.
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Projection =⇒ Geographic

Horizontal Datum =⇒ North American Datum 1983 (NAD83)

Horizontal Units =⇒ Decimal Degrees

3. Land Use

The land use data used for this study is obtained from National Land Cover Dataset

(NLCD 92), which is distributed by USGS. The 1 Arc Second (approximately 30m) reso-

lution data is downloaded from USGS website (http://seamless.usgs.gov/viewer.html) in

ArcGRID format. NLCD data is compiled using Landsat TH (Thematic Mapper) 1992

imagery (USGS, 2003).The downloaded data has the followingproperties:

Projection =⇒ Geographic

Horizontal Datum =⇒ North American Datum 1983 (NAD83)

Horizontal Units =⇒ Decimal Degrees

This data is re-projected to UTM Zone 14 using ArcToolBox. NLCDhas a 21-

category land cover classification scheme. This scheme is obtained after modifying An-

derson Level II land use and land cover classification. The 21classes of NLCD are listed

in Table 6.

TABLE 6.: NLCD Classes (USGS, 2003)

Water
11 Open Water
12 Perennial Ice/Snow
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TABLE 6.: (Continued)

Developed
21 Low Intensity Residential
22 High Intensity Residential
23 Commercial/Industrial/Transportation

Barren
31 Bare Rock/Sand/Clay
32 Quarries/Strip Mines/Gravel Pits
33 Transitional

Vegetated; Natural Forested Upland
41 Deciduous Forest
42 Evergreen Forest
43 Mixed Forest

Shrubland
51 Shrubland

Non-natural Woody
61 Orchards/Vineyards/Others

Herbaceous Upland
71 Grasslands/Herbaceous

Herbaceous Planted/Cultivated
81 Pasture/Hay
82 Row Crops
83 Small Grains
84 Fallow
85 Urban/Recreational Grasses
Wetlands
91 Woody Wetlands
92 Emergent Herbaceous Wetlands
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4. Soils

The soils data is obtained from State Soil Geographic (STATSGO) Database main-

tained by National Resources Conservation Service. The soil maps for STATSGO are de-

veloped by generalizing the soil survey data at 1:250,000 scale (NRCS, 2004). The data

for the state of Texas is downloaded in Arc/Info coverage format. This data is clipped to

cover the study area in order to save the processing time. Thedownloaded data has the

following properties:

Projection =⇒ Albers Conical Equal Area

Units =⇒ Meters

1st Standard Parallel =⇒ 29 30 00

2nd Standard Parallel=⇒ 45 30 00

Central Meridian =⇒ -96 00 00

Latitude of Origin =⇒ 23 00 00

False Easting =⇒ 0.00

False Northing =⇒ 0.00

Horizontal Datum =⇒ North American Datum 1927

Ellipsoid Name =⇒ Clark 1866

The data is re-projected using ArcToolBox to UTM Zone 14 usingHorizontal Datum

of NAD 1983.

C. PrePro2004 Interface Application

The detailed instructions to use the interfaces in PrePro2004 are prepared in the form

of tutorials. These tutorials are included in Appendix B andC. Tutorials also explain the

format of input data required. This section discusses only some of the steps and outputs
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obtained.

1. Path Setup

The Path Setup is accessed from PrePro2004 menu (Fig. 27). This menu item is

used to define the path on the disk to store the outputs files.

FIG. 27. Path Setup
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A new folder with name Scenario1 is created at the chosen path. If Scenario1 already

exists then Senario2 is created, if Scenario2 already exists then Scenario3 is created and

so on.

2. Watershed Delineation

Watershed delineator is accessed by the menu item under PrePro2004 (Fig. 28). It

delineates the streams and watersheds based on the methodology described in Chapter

III.

FIG. 28. Watershed Delineator
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DEM and stream layers are selected using the browse buttons (buttons with folder

icons). A mask is loaded to define the extent of DEM to be used for processing. The use

of mask reduces the time of processing. The DEM processing starts from burning streams

in the DEM, followed by filling of sinks and flow direction calculation. The resulting

grids of clipped and burned DEM, filled DEM, flow direction andflow accumulation are

shown in Fig. 29.

Clipped and Burned DEM

High : 5460.07

Low : 140.223

(a) Clipped and Burned DEM grid

Filled DEM

High : 5460.07

Low : 5140.53

(b) Filled DEM grid

Flow Direction

1

2

4

8

16

32

64

128

(c) Flow Direction grid

Flow Accumulation

0

0 - 49,833.8125

49,833.81251 - 124,584.5313

124,584.5314 - 224,252.1563

224,252.1564 - 299,002.875

299,002.8751 - 373,753.5938

373,753.5939 - 448,504.3125

448,504.3126 - 523,255.0313

523,255.0314 - 598,005.75

598,005.7501 - 672,756.4688

672,756.4689 - 747,507.1875

747,507.1876 - 822,257.9063

822,257.9064 - 897,008.625

897,008.6251 - 971,759.3438

971,759.3439 - 1,345,512.938

1,345,512.939 - 1,395,346.75

1,395,346.751 - 1,694,349.625

1,694,349.626 - 1,818,934.156

1,818,934.157 - 3,538,200.688

3,538,200.689 - 3,787,369.75

3,787,369.751 - 4,186,040.25

4,186,040.251 - 4,360,458.594

4,360,458.595 - 4,509,960.031

4,509,960.032 - 4,634,544.563

4,634,544.564 - 4,734,212.188

4,734,212.189 - 4,858,796.719

4,858,796.72 - 4,908,630.531

4,908,630.532 - 5,058,131.969

5,058,131.97 - 5,182,716.5

5,182,716.501 - 5,282,384.125

5,282,384.126 - 6,204,309.656

6,204,309.657 - 6,378,728

(d) Flow Accumulation grid

FIG. 29. Results after Processing of DEM
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The streams were defined from flow accumulation grid by providing a threshold

value of 40000. Thus, all the points having a drainage area of4 square kilometers (40000

x 10 m x 10 m) become part of the stream network. The stream network obtained after

delineation conforms to the NHD stream network (Fig. 30).

Streams from delineation

NHD Streams

FIG. 30. Delineated Streams and NHD Streams Network

In the stream delineation process, outlets are also defined.Outlets are located at the

end point of streams. As mentioned in Chapter III, inlets, outlets or reservoirs points

can be added to the stream network. Fig. 31 shows the delineated streams, watersheds,

outlets and reservoirs.
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MonitoringPoint

Outlet

User-defined Outlet

Inlet

Reservoir

Reach

Watershed

FIG. 31. Stream Network, Watersheds, Inlets, Outlets, and Reservoirs
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Once the watershed delineation is done, HMS elements are created using the inter-

face (Fig. 32). The HMS elements are stored in watershed shapefile, streams shapefile,

junctions shapefile, reservoirs shapefile and sources shapefile.

FIG. 32. Interface: HMS Elements, Merge Watersheds and Calculate Parameters

The subbasins can be merged together as shown in the Fig. 33. The numbers shown

in the figure are the GridCode values for reaches and subbasins. The subbasins with

GridCode 78 and 83 are merged to get a resulting subbasin with GridCode 78. The

GridCode value of a reach is same as the GridCode value of the subbasin to which it

belongs. In the shown figure, reaches with GridCode 78 and 83 belongs to subbasin with

GridCode 78 and 83, respectively. After merging the subbasins, both the reaches belong

to subbasin with GridCode 78. This information is stored in the attribute table of reach

through a field WshCode which stores the GridCode of subbasin to which it belongs. In

the shown figure, the WshCode for both the reaches is 78. The smaller subbasins are
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merged to the bigger subbasins in this example to avoid having a lag time smaller than

the simulation time step in HMS model.

FIG. 33. Reach Parameters After Merging Subbasins

The subbasin and reach parameters are calculated using the ‘Calculate Parameter’

button (Fig. 32). The list of parameters calculated is shownin Table 7.

TABLE 7.: Subbasin and Reach Parameters

Subbasin Parameter
Longest flow path length

Longest flow path slope between endpoints

Elevation of start and end points of longest flow path

Longest flow path slope between 10% and 85%

Centroidal flow path length
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TABLE 7.: (Continued)

Elevation of centroid of subbasin

Latitude and Longitude of centroid of subbasin

Subbasin slope

Reach Parameter
Reach length

Reach slope

Elevation of start and end points of the reach

The parameters shown in Table 7 are stored in SubbasinParam table and ReachParam

table for subbasins and reaches, respectively. Along with these parameters the table Sub-

basinParam also stores the average curve number, average base curve number, and aver-

age impervious cover percentage if they are The network topology is determined based

on a common attribute between streams, watershed, junctions and reservoir shapefiles.

This common attribute is GridCode. The watershed features have a unique GridCode

value. The stream features have an attribute WshCode that stores the value of watershed

GridCode to which it belongs. Likewise, junction and reservoir features have an attribute

that stores the value of watershed GridCode to which it belongs. In order to establish the

topology, It is imperative to know the orientation of each element with respect to other

elements. Elements here refer to subbasin, stream, junction, reservoirs and inlet features.

All the elements should have a unique global identifier in order to create the basin model

for HMS. Therefore, a text field HMSCode is added to attribute table of all the elements

which stores the unique identifier. Further to establish thetopology, the elements are

attributed with DownCode to successfully trace the network.The DownCode attribute of

an element stores the HMSCode of the element downstream to it (Fig. 34).
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(a) Subbasin Parameter Table

(b) Reach Parameter Table

FIG. 34. Results after Calculating Parameters
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3. Curve Number

Average curve numbers for each subbasin are calculated using the land use data,

soil type data, curve number lookup table, and watershed polygons. The curve number

values are shown in Fig. 35. The curve numbers are calculatedusing shapefiles of land

use and soil type data. The calculation of curve numbers using grids is shown in the

tutorial (Appendix B).

HMS Subbas in

Curve Number

61

65   66

69   70

71   72

73   74

75   76

77   78

79   80

81   82

83   84

FIG. 35. Curve Numbers for the Study Area
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It can be clearly seen that the lower part of the basin has higher values of curve num-

bers. It should be noted that the lower part of the basin lies in the San Antonio city limits,

thus resulting in higher values of curve number. The base curve number and impervious

cover values, averaged over subbasin, are calculated. The average curve number, aver-

age base curve number and average impervious cover percentage are stored in subbasin

feature attribute table with field names AverCN, AverBCN, and AverIC, respectively.

4. Gage Weights Using Thiessen Polygons

The gage weights of the precipitation gages for each subbasin are calculated based

on the thiessen polygons. Three precipitation gages were assumed to exists in the study

area. PrePro2004 tools are used to create the Thiessen polygons for the gages, inter-

sect the thiessen polygons with the watershed polygons, andcalculate the area-weight of

gages for each subbasin. A shapefile GageWeights is generated which store the polygons

resulting from intersection of watershed polygons and the thiessen polygons for the gages

(Fig. 36).



78

‘̂

‘̂

0.85 [0]

0.62 [1]

1.00 [1]

1.00 [0]

1.00 [0]

0.38 [0]
1.00 [0]

1.00 [1]

1.00 [1]

0.70 [0]

0.98 [1]

1.00 [1]

1.00 [1]
0.94 [0]

1.00 [1]

1.00 [1]

1.00 [0]

0.58 [1]

1.00 [1]

1.00 [1]

1.00 [0]

1.00 [0]

1.00 [1]

0.73 [1]

0.82 [1]

0.42 [0]

0.15 [1] 1.00 [1]

0.92 [1]

1.00 [1]

1.00 [1] 1.00 [1]

0.30 [1]

1.00 [1]

1.00 [0]

1.00 [1]

1.00 [1]

1.00 [0]

1.00 [0]

1.00 [0]

1.00 [0]

0.27 [0]

1.00 [0]

0.18 [0]

1.00 [0]

0.06 [1]

0.08 [0]

1.00 [1]

0.02 [0]

Gage1

Gage0

FIG. 36. GageWeights Shapefile and Precipitation Gages

Two of the three precipitation gages are shown in the Fig. 36.The labels shows the

gage weight and the gage identifier (in the bracket) for each subbasin. For example, the

highlighted subbasin gets 0.38 weight for the gage 1 and 0.62weight for the gage 2. The

calculated gage weights are exported to the Project geodatabase.

5. Data Processing

The results are exported to Basin geodatabase using the ‘Export Data to IDM’ menu

item. Note that only Basin geodatabase can be populated, as none of the meteorological

parameters are calculated for the case study. Since only oneprecipitation gage is used for

Salado creek basin, there is no need to calculate the gage-weights. Also, since the gaged
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precipitation is used for the application, there is no need to create a grid-cell parameter

file. The capabilities of the tool to calculate the gage weights and grid-cell parameters

is shown in the tutorial (Appendix B). The〈SubbasinParam〉 and〈ReachParam〉 tables

are added to the Basin geodatabase. These tables store the extracted parameters listed in

table. 7. The subbasin lag time is calculated using the ‘Calculate Parameters’ menu item,

as shown in Fig. 37.

FIG. 37. Calculate Parameters Menu Item and Window
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〈LossRateSCS〉 table is populated with impervious cover percentage and average

base curve number values for each subbasin.〈TransformSCS〉 table is populated with

subbasin lag time for each subbasin. Once the Basin geodatabase is populated with data,

it can be used to create the HMS basin input file. The interfacefor creating the basin

model can be accessed from the toolbar shown in Fig. 38.

FIG. 38. Basin Model Menu Item and Window

{HMSSubbasin} feature class have text fields LossRate, hTransform, and BaseFlow

which stores the lossrate method name, transform method name, and baseflow method
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name, respectively, to be used by each subbasin. Thus, basedon the method to be used

for different processes, the appropriate table in the Basin geodatabase is accessed for the

parameters. In this example, we are using SCS lossrate method, SCS transform method

and no baseflow. In order to transfer the parameters of a different lossrate, transform

and baseflow methods, we need to update the{HMSSubbasin} feature class accordingly.

Therefore, the created basin file stores the parameters for SCS lossrate method and SCS

transform method for each subbasin based on the data stored in tables LossRateSCS

and TransformSCS. In order to use any other method, the user will need to populate the

above mentioned fields accordingly. The description of the value to be used in the differ-

ent fields is provided in the tutorial (Appendix B).{HMSSubbasin} feature class is added

to ArcMap. The field calculator is used to populate the fields LossRate, hTransform and

BaseFlow with values SCS, SCS and None, respectively. The Pure lag method is used

for reach routing. The lag time (in minutes) is calculated byassuming a velocity of 1.5

m/s for all the reaches. The tools are provided and discussedin Appendix B to calculate

the lag time and populate the table RouteLag in the Basin geodatabase. Once we update

the feature class, it will ensure the successful transfer ofcalculated curve numbers and

subbasin lag times to the basin model. The basin model is created as an ASCII text file.

This text file is imported to HEC-HMS interface. A background map file is created for

display purposes only. The outputs from this tool are shown in Fig. 39.
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(a) Geodatabase to HMS Basin Model

(b) Basin Model File

(c) Background Map File

FIG. 39. Basin Model Schematic and Map File
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Fig. 40 the element list of the HMS basin model. It shows the lossrate method and

transform method used for each subbasin, and the routing method used for reaches. It also

lists the downstream element to each element under the column heading ‘Downstream

Name’.

FIG. 40. Basin Model Set Up

Fig. 41 shows the parameters transferred to the basin model.
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(a) SCS Lossrate method parameters (b) SCS Transform method pa-
rameters

(c) Reach routing Lag method
parameters

FIG. 41. Subbasin Lossrate, Subbasin Transform and Reach Routing Parameters
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The meteorological model text file is created from the data stored in the Project

geodatabase using the PrePro2004 tools. The text file is imported in the HMS interface.

The imported meteorological model is shown in the Fig. 42.

FIG. 42. Meteorological Model

Before importing the meteorological model, three gages withgage ID 0, 1, and 2 are

added using the HMS interface.The precipitation data were obtained from the National

Climatic Data Center’s NNDC Climate Data Online website. Fig. 43 shows the added

gage to the HMS model and the precipitation data associated with that gage.
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FIG. 43. Gages and Precipitation Data for Gage 0

The precipitation data for the gages is entered in the DSS fileusing the DOS based

utility created by HEC. Appendix A details the steps for usingthe DOS utility.

The basin model includes one source and three reservoirs. The source is assumed to

be discharging 100 cfs to the study area and having an area of 2square miles upstream

to it. The Storage-Elevation-Outflow routing method is usedfor the reservoirs. The data

for the methods is obtained from the HMS model obtained from PBS&J, Austin. Fig. 44

shows the data for one of the reservoirs.
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FIG. 44. Storage-Elevation-Outflow Data for Reservoir

The control specifications are entered from the HMS interface. The starting date and

time of 01 Sep, 1996 (01:00), the ending date and time of 07 Dec, 1996 (12:00), and the

time step of 5 minutes is used for the simulation (Fig. 45). Fig. 46 shows the successful

running of the HMS model.
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FIG. 45. Control Specifications

FIG. 46. HMS Run Window
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The second part of the application is included as a tutorial in Appendix C. This tu-

torial describes the importation of an existing HMS model inside the geodatabase. The

HMS model for Salado Creek was obtained from PBS&J, Austin. TheHMS model

project definition, the basin model, the meteorological model, and the control specifica-

tions are shown in the Fig. 47. The tools for storing this HMS model inside the geo-

database are accessed from the menu item HMStoIDM in the PrePro2004 toolbar.

The interface shown in Fig. 48 is used to perform the transferoperation. The target

basin geodatabase and the target project geodatabase are accessed to store the data. The

user can choose which file he/she wants to transfer. The checkbox before the file name

will tell the interface which file should be transferred. Allthe files except the DSS file

are text files. The DSS is a data storage system created by HEC. The user can transfer

either paired data or time series data at a time from the DSS file. The user should chose

the appropriate option button for the type of DSS data to be transferred. A button Set

Up DSS Query is used to create a query statement for data retrieval from DSS file. In

this example, the storage-flow data (paired data) for a reservoir 0010S and the cumula-

tive precipitation data (time series data) for Gage 1 is transferred from DSS file to the

geodatabase. Appendix C details the steps, in the tutorial form, to determine the query

statement.
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(a) HMS Project Definition (b) HMS Basin Model

(c) HMS Meteorological model (d) HMS Control Specification

FIG. 47. Salado Creek HMS Model
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FIG. 48. HMS to IDM Transfer Interface
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The transferred data is stored in appropriate feature classor table as explained in

methodology. Fig. 49 shows the data inside the basin geodatabases. They data shown

in the Fig. 49, in the order from top to bottom, is from the table HMSBasinHeader, the

attribute table of HMSSubbasin feature class, the attribute table of HMSReservoir feature

class, the table RouteMuskingum, and the table LossRateSCS in the basin geodatabase.

It should be noted that the figure do not show all the fields for the table, all the data inside

the tables, and all the tables and feature classes inside thebasin geodatabase.

The data inside the project geodatabase is shown in the Fig. 50. The tables shown

in the figure are, in the order from top to bottom, ProjectHeader, ProjectControls,

ProjectRuns, MeteorologicalHeader, MeteorologicalUserHyetograph, and DSSTime-

Series. It should be noted that the figure do not show all the fields for the table and all

the data inside the tables inside the project geodatabase. The HMS project file stores the

names and paths of the basin files, meteorological files and control files. It also stores the

default parameters to be used in the basin model and the meteorological model.
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FIG. 49. Data inside the Basin Geodatabase
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FIG. 50. Data inside the Project Geodatabase
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The basin geodatabase have the data in attribute tables of the feature classes, but the

feature classes does not have the shapes data as HMS does not store the shapes data. The

shapefiles created using other pre-processor for HMS can be used to transfer the shapes

data to the geodatabase. Fig. 51 shows the transferred shapes data in HMSSubbasin

feature class for the Salado Creek.

FIG. 51. Shapes in HMSSubbasin Feature Class

A second case study (Appendix B) describes the capabilities of the tools to create a

HMS model for Bull creek watershed.
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CHAPTER V

CONCLUSIONS

The objective of this thesis is the development of an ArcGIS interface and data

model for creating inputs for Hydrologic Engineering Center’s Hydrologic Modeling

System (HEC-HMS). A methodology is devised based on the DataCentric coupling strat-

egy. This methodology aims to harness the data handling capability of geographic infor-

mation system (GIS). The DataCentric approach will allow theutilization of the same

data, in part or whole, by another hydraulic or hydrologic model. This approach is

promising in bringing the different models together as wellas complementing and/or

comparing the results.

PrePro2004 is being developed to utlilize the additional data handling and managing

capability of GIS. The basic concepts used in the development of PrePro2004 are

• Geodatabase data model: a repository to store spatial and tabular data at same place

• Hydrologic data model: models created by customizing geodatabase data models

to meet the requirements of hydrologic data.

• Component Object Model: a Microsoft’s technology which establishes communi-

cation protocol between different applications

PrePro2004 pre-processes the input raster and vector data to create HMS input files.

It post-processes HMS output and stores it back in geodatabases. It allows the conversion

of HMS model from flat ASCII files to a geodatabase format as wellas the reproduction

of ASCII files from geodatabase. The advantages of geodatabase over ASCII files can be

listed as:

• Sharing of data is easier.
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• Data organization is more intuitive in geodatabase. The spatial elements stored in

feature classes have relationship to tables storing model parameters. ArcMap can

be used for effective visualization of spatial and temporaldata.

• The data in geodatabase, in part or whole, can be utilized forinput to other hy-

drologic or hydraulic model. This can be achieved by developing code in COM

compliant language (e.g. VBA, VC++) for ArcGIS, ArcCatalog orMS Access. As

a long-term goal, the data inside geodatabase can be used to create input for other

hydrologic or hydraulic models.

• Relationships between the geographical entities and data related to them provides

better information for engineering judgement

Two case studies are presented to show the application of methods developed. The

first case study, Appendix B, presents the application of methods to delineate water-

sheds based on 10 m DEM, and calculate curve numbers based on NLCD land use and

STATSGO soil type data for the Bull creek watershed. The inputtext files are created and

successfully imported to HMS project. The second case studyis presented in Appendix

C for Salado creek watershed which illustrates the successful transfer of existing HMS

model to geodatabases.

Every model has its limitations, as does this one. These limitations can be exploited

for further research. Known limitations of the interface are:

• Use of vector data for curve number calculation is time consuming

• Interface does not allow the closing of ArcMap and restarting from same

point until the data is exported to geodatabases, even if themap is saved.
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APPENDIX A

FORMAT OF TABLES FOR CURVE NUMBER CALCULATION

Lookup table stores the curve number values and impervious cover percentages for hy-

drologic soil groups for different types of land uses (see table shown below) . The table

provided here is created according to NLCD land use classification. The curve num-

ber values are approximated from the values provided by (Wurbs and James, 2002) for

Anderson Level II land use classification.
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LUCODE LANDUSE CNA CNB CNC CND IMPERVIOUS

11 Open Water 100 100 100 100 0

12 Perennial Ice/Snow 100 100 100 100 0

21 Low Intensity Residential 57 72 81 86 20

22 High Intensity Residential 61 75 83 87 20

23 Commercial/Industrial/Transportation 89 92 94 95 45

31 Bare Rock/Sand/Clay 77 86 91 94 0

32 Quarries/Strip Mines/Gravel Pits 77 86 91 94 0

33 Transitional 43 65 76 82 0

41 Deciduous Forest 36 60 73 79 0

42 Evergreen Forest 36 60 73 79 0

43 Mixed Forest 36 60 73 79 0
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The table shows a typical lookup table. User can create his own lookup table keeping the

name of the fields same as shown. The fields are described below:

LUCODE is the field to store the land use codes for various land uses and is the key field

to establish relation with land use shapefile or raster grid,

LANDUSE is not a mandatory field. It describes the LUCODE field verbally,

CNA is the curve number for hydrologic soil group A corresponding to different land

use,

CNB is the curve number for hydrologic soil group B corresponding to different land

use,

CNC is the curve number for hydrologic soil group C corresponding to different land

use,

CND is the curve number for hydrologic soil group D corresponding to different land

use,

IMPERVIOUS field represents the impervious cover in percentage corresponding to the

land use.

The next table, shown below, has to be provided when curve number calculation

utilizes the land use raster grid and soil type raster grid. Note that the name of the table

‘HSGTable’ should not be changed and it should be stored on hard disk at the same

location as the soil type raster grid. The name of the fields should also remain same.

Value MUID A PCT B PCT C PCT D PCT

1 TX153 0 13 56 31

2 TX155 0 71 12 18

3 TX521 0 0 27 73

4 TX071 0 11 34 55
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The fields in this table are described as follows:

Value is the field to establish relationship with soil data grid,

MUID is the field for soil description (optional),

A PCT stores the percentage of hydrologic soil group ‘A’ in the soil,

B PCT stores the percentage of hydrologic soil group ‘B’ in the soil,

C PCT stores the percentage of hydrologic soil group ‘C’ in the soil,

D PCT stores the percentage of hydrologic soil group ‘D’ in the soil.

This table can be created using MS Excel with minimal effort.The table shown

above w as created for the State Soil Geographic (STATSGO) data of the study area.
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APPENDIX B

PREPRO2004 USER’S MANUAL - PART I

Prepared by Francisco Olivera, Ph.D., P.E., Srikanth Koka and Ashish Agrawal

Department of Civil Engineering, Texas A&M University

CONTENTS:

1. Brief Overview of Delineating Watersheds and Stream Networks

2. Goals of the Exercise

3. Computer and Data Requirements

4. Loading Toolbar

5. Get Familiar With the DEM Data

6. Set Up the Project

7. DEM Setup

8. Provide a Mask, Burn-in Streams

9. Fill Sinks, Flow Direction Grid, Flow Accumulation

10. Construct the Basic Stream Network

11. Rain Drop Tool

12. Add Streams to the Stream Network

13. Add Outlets

14. Delineate Streams and Watersheds

15. HMS Elements

16. Merge Sub-Basins

17. Add Flow Change Location/Add Reservoir

18. Calculate Parameters
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19. Curve Number Calculation

20. Grid Cell Parameter File

21. Gage Weights Calculation

22. Export Data to IDM

23. Calculate Parameters (Menu Tool/IDM/HMS)

24. Data preparation to create HMS input

25. IDM to HMS

(a) Basin File

(b) Meteorological File

(c) DSS File

26. Importing text files to HMS

27. Running HEC-HMS model

1. Brief Overview of Delineating Watersheds and Stream Networks

One of the most important applications of Digital ElevationModels (DEMs) is wa-

tershed delineation. ArcGIS and its Spatial Analyst extension have built-in functions for

watershed delineation from DEMs. In this tutorial, PrePro2004 is presented where Pre-

Pro stands for PreProcessor of GIS data for the Hydrologic Modeling System developed

by Hydrologic Engineering Center of U.S. Army Corps of Engineers.

2. Goals of the Exercise

In this exercise, you will learn how to use PrePro2004 to process a digital elevation

models and to delineate watersheds and stream networks fromit. The tools discussed

here will be used to delineate the part of Bull creek watershedlocated in north-west of

Austin. Bull creek is part of Guadalupe basin.

3. Computer and Data Requirements

Computer Requirements
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This exercise was successfully completed using ArcView 9.0(Product version: 9.0.0.538;

ArcGIS Service Pack: 1 (build 9.0.0.550), Spatial Analyst Extension and 3D Analyst Ex-

tension. The outputs are successfully imported to Hydrologic Modeling System (HMS)

version 2.2.2.

Operating System: Window XP

To check the version of ArcGIS and Service Pack on your computer, look forDesktop

Administrator in the Start menu of window. Usually it is located in the same menu

as ArcMap. To open the Desktop Administrator, you will need toclose all the ArcGIS

applications (i.e. ArcMap, ArcCatalog, ArcToolBox) Check the product version of ArcGIS

and the service pack information.

The later versions of service pack should also work for the tools as they include all

the things included in Service Pack 1, as said by ESRI.If you do not have the desired

service pack for ArcGIS 9.0, it is available from ESRI’s website at no cost. This link can

be used to download the service packhttp://support.esri.com/index.cfm?fa=downloads.

patchesServicePacks.viewPatch&PID=15&MetaID=910(Date browsed: 01/28/05). Scroll

down the page to look for headingArcGIS Desktop (Arc/Info, ArcEditor, ArcView) and

download/install ArcGISDesktop90sp2.msp. Follow the instructions on the webpage to

successfully install the service pack.

Unzip the folder PrePro2004.zip to your hard disk to a new folder and name

it PrePro. You should get two folders ’PrePro2004’ and ’Tutorial’.PrePro2004 folder

contains the installation files for the toolbar.Tutorial folder contains the data required

and text to run the exercise.

The data needed for the exercise consist of the following datasets:

Tutorial\Data\InputData\WshDelineation

BullCkNHD.shp – shapefile of the NHD (National Hydrographic Dataset) streamnet-
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work of the Bull Creek basin

bullckdem – Grid of elevation for the Bull Creek Basin region

bullmask – Grid, which will be used as a mask so that only the part of the DEM contain-

ing Bull Creek Basin is processed

Tutorial\Data\InputData\CurveNo

cndbf.dbf - a dbf table of Curve numbers for different land use and soil percentages

Tutorial\Data\InputData\CurveNo\Grid

Bulllu – Grid of Land use for Bull Creek Basin

Bullsu – Grid of Soil use for Bull Creek Basin

HSGTable.dbf –a dbf table of the percentages of groups for soil types

Tutorial\Data\InputData\CurveNo\Shapefile

Landuse.shp –shapefile of land use of Bull Creek basin

Soiltype.shp –shapefile of soil type of Bull Creek basin

Tutorial\Data\InputData\Geodatabases

Basin.mdb –an Access geodatabase to store the information about the basin model of

HMS

Project.mdb – an Access geodatabase to store information about the meteorological

model, control model and project specific information of HMS

Tutorial\Data\InputData

Betagages.shp –shapefile of precipitation gages near Bull Creek basin

Fishnet.shp –shapefile of grid-cells representative of NEXRAD grid cells

Tutorial\Data\InputData\PrecipData

BullA.txt - text file with precipitation data for gage BullABullB.txt - text file with pre-
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cipitation data for gage BullBBullC.txt - text file with precipitation data for gage BullC

Tutorial

dssts.exe- Executable to create DSS file from precipitation text files.This program is

created by Hydrologic Engineering Center of U.S. Army Corp of Engineers.

If you plan to use your own datasets then make sure that (1) Data is projected

and (2) is in the same format as required by the interface. The format of input data

required is discussed further in text.

4. Loading the Tool

Inside the folder ’PrePro2004’ (which should be located inside the folder where

the files are unzipped, PrePro). Locate the fileSetup.exeand double-click to run setup.

It will automatically register all the components. Administrative rights might be needed.

Installing toolbar at the default location suggestion by the set up program is strongly

recommended.

During the setup if a message box comes up saying ’Unable to copy the file, it is

already in use’, then pressIgnore. This will be followed by another message box which

will ask do you want to continue with setup, pressYES.

Finally, a message box reporting successful installation will show up. Now open the

ArcMap, a toolbar with titlePrePro2004should appear in the ArcMap. If the toolbar

do not appear then, goto Tools→ Extensions and check the box before ’PrePro2004

Extension’. Then goto View→ Toolbars and select PrePro2004. Now the toolbar should

show up.

5. Getting Familiar with the DEM Data

(1) In the map document, click theAdd Data button.

(2) Holding theShift key, addbullckdem, bullmask andBullCkNHD.shp from

your data directory to a data frame(located at Tutorial\Data\InputData\WshDelineation).
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Click onDo not build pyramids and thenOK . Repeat as necessary. Move the bullmask

layer below the bullckdem by clicking on it, dragging it to the new location, and then

releasing the mouse button.

(3) Look at the properties of the DEM by right-clicking on theDEM and then click

on Properties. In theLayer Properties wizard, choose theSourcetab to view the grid

properties. As can be seen in the wizard, the DEM hasNAD 1983UTM Zone 14N

projection, a cell size of 10 m, a minimum elevation of 147.20m and a maximum ele-

vation of 337.30 m. You may have to scroll down in the Data Source window to see the

projection. ClickOK to close the window.

6. Setting Up the Project

Setting up the project consists of defining the directory path for the utilities to store

the results.

(1) Click Prepro2004/Path Setup. In the window that appears, select a drive in the

top dialogue box. In this drive, select a folder in theBrowse to the Folderwindow.
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(2) Inside the selected folder, create a new folder with any name, Results recom-

mended, by clicking on the New Folder button. After enteringthe name for the folder,

click OK . On the window titled ’Select the Project path’ click OK to proceed. A mes-

sage box should appear showing the path of the folder, Scenario1 inside the folder defined

by you; click OK. (e.g. ”C:\Documents and Settings\s0k9138\Desktop\ArcGISCourse

\HydrologicAnalysis\Scenario1” will be shown in the message box as seen in the image

above. If you again chose Hydrologic Analysis for path setup, a folder Scenario2 will

be automatically created and you will be informed). All the output shapefiles and grids

generated during the processing will be stored at this location.

7. DEM Setup

This section consists of specifying the DEM and verifying that the DEM has spatial

reference defined to it.

(1) Click Prepro2004/Watershed Delineator. A window namedWatershed Delin-

eation Toolsappears that contains a number of tabs, each containing different functions.

Until the end of the exercise, this window will be used.

(2) To specify the DEM dataset, click on the button containing the folder icon located

under the tab namedDEM Setup in theWatershed Delineation Toolsform.
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(3) A window calledSelect Option – Open DEMwill appear. In this window,

select theSelect from Viewoption and clickOK .

(4) In theSelect the Layerwindow that opens, selectbullckdem and clickOK . Up

to this point you have specified the DEM required. Now you needto verify that the DEM

is projected properly.

(5) Click theProjection button located under theDEM Setup tab in theWatershed

Delineation Toolswindow. The Properties wizard appears; take note of the information

provided and clickOK . Make sure thatWatershed Delineation Toolsform is not closed

until otherwise instructed.

8. Provide a Mask, Burn-in Streams

You are now going to specify a mask concerning the study area.When a mask is

used, only the part of the DEM falling within the mask is processed.

(1) Go to theWatershed Delineation Toolsform with theDEM Setup tab active

and insert a checkmark forMask under theMask/Burnin Section tab. Now click on the

folder icon forMask.
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(2) In the window titledSelect Option-Mask that appears, select theSelect from

View option and clickOK . A new form titledSelect the Layerwill open. Selectbull-

maskand clickOK .

You are now going to raise the land surface cells that are off the streams by an

arbitrary elevation amount so that the streams delineated from the DEM exactly match

those in NHD.

(3) In theWatershed Delineation Toolwindow with theDEM Setup tab active,

under theMask/Burnin section, insert a check mark forBurn in .

(4) Now click on the folder icon forBurn in . In the window titledSelect Option-

Burnin that appears, select theSelect from Viewoption and clickOK . A new window

titled Select the Layerwill open. SelectBullCkNHD and then clickOK .
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Before you burn in the streams you have to ensure that the stream network is contin-

uous and there are no gaps between each stream segment as wellas it drains outside the

mask or actual DEM. If such gaps exist they must be edited and closed before you burn

in the streams. Likewise, you must edit out miscellaneous stream lines in the landscape

that are not connected to the stream network.

9. Fill Sinks, Flow Direction Grid, Flow Accumulation

Up to this point of the exercise, your Watershed Delineator form should look similar

to the image below:

Most of the DEM data are accurate; however, aberrations do occur in the DEM

which cause pits to form in the terrain. These pits need to be filled; otherwise they will

cause the wrong flow direction. TheFill sinks function raises pit cell elevations to level

the pits with the surrounding terrain. Only artificial sinkswill be filled because real

sinks, which we do not wish to remove from the DEM, are treateddifferently. With the
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DEM grid filled, the flow direction grid can be calculated. Once the flow direction grid

is computed, the flow accumulation grid will be calculated. All 3 of these functions (fill

sinks, flow direction and flow accumulation) will be applied at the same time.

(1) In theWatershed Delineation Toolwindow, click on theFIL/FDIR/FACC but-

ton located underMask/Burnin section. It will take some time to execute these functions.

Once done, a message appears indicating the completion of the process.

(2) Click OK to continue and then minimize the watershed delineation tool window

(DO NOT CLOSE IT!) and try exploring the newly added layers to the Table of Contents

(TOC). These layers areTargetDEM , FACC, FDIR and FIL . To see only the Filled

DEM, make all layers invisible except forFIL in theTOC.

(3) Similarly, to see only the Flow direction grid, make all layers invisible in the

TOC except forFDIR .

(4) To see only the Flow accumulation grid, make all layers invisible in theTOC

except forFACC.
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Keep in mind that in the flow accumulation grid, the lighter the colors of an individ-

ual grid cell then the more grid cells drain into that particular cell.

(5) Click on theZoom In tool (standard tool of ArcMap) and zoom into a spot in

the lower right corner where the two streams join in the grid network. Use theIdentify

tool (standard tool of ArcMap) to check individual cell values and understand how the

flow accumulation function counts the number of cells upstream of a particular cell.

(6) Follow a particular stream downstream and see how the flowaccumulation value

increases as more drainage area is picked up. Focus on a junction and see how the flow

accumulation downstream of the junction is the sum of the flowaccumulations in the two

upstream tributaries. See the example shown below:
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10. Construct the Basic Stream Network

Before you start to construct the stream network, you must define the cell threshold

or minimum stream drainage area.

(1) In theWatershed Delineation Toolform click on theStreamstab, enter a value

of 15000 as the number of cells in the text box forThreshold: and click theSTR button.

(2) A streams grid is formed having a value of 1 in each cell, a flow accumulation

value larger than 15000, and NODATA on all other cells. Aftersome time a message box

will appear saying that the function was successfully executed. Four new layers will be

added to the map – Monitoring Point, Reach, OUT and STR. STR is a raster containing

streams, OUT is raster containing cells that are outlets of streams being flagged, Reach is

line shapefile that correspond to the streams of STR and Monitoring point is a shapefile

containing outlet points corresponding to the outlet cellsin the OUT raster.

(3) Now minimize theWatershed Delineation Toolform and make only the STR
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layer active by making the other 3 invisible in theTOC. Also make theTargetDEM and

BullCkNHD layers visible.

(4) To see if the streams delineated are correct, compare them with BullCkNHD

streams. Do this by dragging theBullCkNHD layer below theSTR layer. Now zoom

into any stream covered by both the layers using theZoom In tool. You should notice

that the stream gridSTR overlaysBullCkNHD with some of the streams ofBullCkNHD

not being covered. This is because the 15000 cell threshold is too large to identify some

of the smaller streams represented byBullCkNHD .



121

11. Rain Drop Tool

TheRain Drop tool can be used to trace the path of a raindrop upon inducing one

on the terrain. The associated tool creates a graphic to showthe raindrop trace path.

(1) Make all the layers in TOC invisible except theTargetDEM layer. Then make

sure that theWatershed Delineation Toolis maximized.

(2) In this form, under theStreamstab, click on theRain Drop (Graphic) button

and then click on the DEM wherever you want. To clear the graphics after observing the

graphic created, click theRefresh Mapbutton in the Watershed Delineation Tool.
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12. Add Streams to the Stream Network

Although you do not want to delineate all of the extra streamsdescribed by the

BullCkNHD , there may be one or a few streams for which you do want the associated

watersheds delineated. For example, there may be a water right location or a stream

gauging station located on that stream for which you want to know the drainage area.

If the stream grid (STR) does not define these streams, you can add the streams

to the STR grid using theADD NEW STREAMS button located on theWatershed

Delineation Toolwindow.

To add streams, the Editor toolbar should be visible. If it isnot then go to Tools→Customize

→Toolbar, selectEditor.

(1) Do this by first zooming to the portion of the map where you want to add a

stream. Next, click on theADD NEW STREAMS button and then click on any point on

the map.

(2) When done, right-click on the map and clickStop Editing. In the form that

appears, clickYesto save changes.

(3) To add the new stream, click on thePROCESS NEW STREAMSbutton lo-

cated on theWatershed Delineation Toolwizard. That could be one of the streams in

BullCkNHD that is not defined by the stream gridSTR. You can now observe that new

layers with the same names replace the 4 original layers, Monitoring Point, Reach, Out

and STR. The new STR layer will contain previous streams plus the extra stream that you

wanted.

(4) To clear the graphics after adding new streams, click theRefresh Mapbutton in

the Watershed Delineation Tool window.

After processing the new streams, Monitoring Point layer will show the points ’StrPnt’

where new streams generate but do not show the newly created outlets. The outlets for the

new scenario are in a different shapefile, IUOutlet.shp, created at ’Results/Scenario1’.
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Later after watershed delineation you will get the appropriate layers in the map.
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13. Add Outlets

The outlet is usually defined as the last cell of each stream section; however, you

can also manually define an outlet.

Make sure theEditor toolbar is visible

(1) Drag theBullCkNHD layer just below theReachlayer.

(2) Zoom into the stream you just added until you can see the individual cells. Make

theOutlet/Inlet/Reservoir tab active in theWatershed Delineation Toolform.

(3) Insert a check forAdd Outlet/Inlet/Reservoir and let theOutlet option be se-

lected.

(4) Click on theADD button in theWatershed Delineation Toolsform, and then

click on a cell. Don’t forget to right-click on the map and then click Stop Editing. Click

Saveat the prompt. You will see new points being added to theMonitoringPoint layer.

Should you decide to delete a point, select theDELETE button and then click on the

point you wish to remove. It should turn blue and a message will appear asking if you

want to delete. Again, right-click upon completion and select Stop Editing.

(5) Open the attribute table of the Monitoring Point layer and find theType field.

Scroll down in the table until you see a row that hasUDOutlet for Type.

14. Delineate Streams and Watersheds

Beforedelineating the watersheds, you will have to select the basin outlet point

from the MonitoringPoint shapefile. The outlet point is the one that is the most down-

stream on the stream network. There are two different streamnetworks so the smaller

one will be disregarded and the bigger one taken into consideration. You will have to

select the outlet of the bigger stream network. Zoom in to themost downstream portion

of the network using theZoom In tool.
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(1) Select the outlet point by inserting a check forInclude Junctions for Delin-

eation in theWatershed Delineation Toolwizard.

(2) Click on theSelectbutton and draw a square around the outlet point to select it.

(3) Click theDELINEATE WATERSHED button to delineate watersheds and streams.

15. HMS Elements

After delineating the watershed, tabVectorizationwill be activated. In the interface,
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press button labeledHMS-Elements. This button will extract the information from exist-

ing shapefiles and create shapefiles which could be directly imported to geodatabase. The

files which are created are watershed, reach, junction, source and reservoir (depending

on the presence of sources and reservoir).

16. Merge Sub-Basins

If you only want the drainage basins for the major streams, you can merge the sub-

watersheds.PrePro2004allows you to merge two sub-basins at a time. Before proceed-

ing with this section, select to view theFull Extent , , of the map document.

(1) Before you merge the sub-basins, check the number of rows in the attribute table

of theWatershed layer. Right-click on the layer name in the TOC and then selectOpen

Attribute Table .

(2) Open theReachattribute table the same way and observe that it has the same

number of streams as theWatershed layer. There is one stream per sub-basin. Some

of the sub-basins may be too small; they need to be merged withtheir neighboring sub-

basins. Close the attribute tables for both layers.

(3) To merge two sub-basins, make sure that theVectorization tab is selected in the

Watershed Delineation Tool.

(4) Insert a check in the box forMerge Subbasinsand minimize theWatershed

Delineation Tool form. In the ArcMap document, click on theSelect Featurestool,

, and then select the two sub-basins as shown in the figure below:

(5) Once you have selected the features, maximize theWatershed Delineation Tool

form and click theMERGE SUBBASINS button. ClickYeswhen asked if you are sure

you want to merge the subbasins.

(6) You should now see that the sub-basins you have selected are merged and the

Watershed layer has one feature less than before. To verify, open the attribute tables
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of theWatershedandReach layers. Compare the number of features between the two

layers. TheReach layer should have the same number of features as before the merge

while theWatershed layer has one less.

(7) You can exit theWatershed Delineation Toolby selectingExit . However, to

continue to the next functions in the PrePro2004 dropdown menu, you must first select

theHMS-Elementsbutton and then theCalculate Parametersbutton in the Watershed

Delineation tool.

17. Add Flow Change Location/Add Reservoir

These buttons will be activated only when you have completedthe watershed delin-

eation.

(1) Select eitherAdd Flow Change Location or Add Reservoir from the Pre-

Pro2004dropdown menu.

(2) After selecting either of them, the mouse cursor will change to cross-hairs with

a circle following the motion. Any desired point can be selected and cursor will auto-

matically snap to the streams.Right-click on the map when finished selecting points and

selectStop Editing.
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(3) A menu appears asking if you want to save edits. If you select Yes, another

window appears asking “Are you sure you want to add New Flow Change Location?” If

you selectNO, all the added points will be gone. If you selectYES, a window appears

providing you the status of the progress. Finally, a messagebox appears confirming the

addition of the new points.

(4) If you had selectedNo when asked about saving edits, all new points would have

been removed.

The next sections of this exercise are in a manual format to describe each function

of the PrePro2004 tool.

18. Calculate Parameters

Press the calculate parameter button to generate the longest flow path for each sub-

basin, HMSCode for each subbasin, extract slope and elevation information from DEM

and establish topology. The data for each subbasin is storedin the attribute table of

’Watershed’ layer and the data for each reach is stored in theattribute table of ’Reach’

layer.
The parameters calculated for watershed layer are listed below and stored in the field

names shown in brackets:

• Length of longest flow path (LongestFL)

• Upstream elevation of longest flow path (USElevLFP)

• Downstream elevation of longest flow path (DSElevLFP)

• Slope of longest flow path for full length (SlpEndPt)

• Slope of longest flow path from 10% to 85% length (Slp1085)

• Length of centroidal flow path (CentFL)

• Elevation of subbasin centroid (CentElev)
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• Latitude of subbasin centroid (CentLat)

• Longitude of subbasin centroid (CentLong)

• Average subbasin slope in percent(WshSlope)

The parameters calculated for reach layer are listed below and stored in the field
names shown in brackets:

• Upstream elevation of river reach (USElev)

• Downstream elevation of river reach (DSElev)

• Slope of river reach (RivSlope)

Note: Do not close the ArcMap if you want perform other operations in the menu

PrePro2004 of the toolbar. Functions in Tools/IDM/HMS can beused even if we close

the map. Like Curve Number Calculation and Change Impervious Cover tools can

also be used in a new ArcMap. But for all the other things the ArcMap session should

not be closed.

19. Curve Number Calculation

After selectingCurve Number Calculation the Curve Number wizard appears as

shown below.
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Curve number needs Land use data, Soil Type data, a lookup table and the watershed

data. The input for Land use and Soil Type data could either bea ‘Shapefile’ or a ‘Raster’.

Make sure you use either Shapefile or Raster for both Land Use andSoil Type (e.g.

Shapefile of Land Use and Raster of Soil Type or vice-versa willnot work). Based

on the input format of data the format of ‘LookUp Table’ will change and is described

further in the document.

a) Using Shapefiles for Land Use and Soil Type

Land Use: Select the browse for folder button (folder icon) in theLand Useframe.

Load the shapefile from disk or add from the map.

Land Use field: Various fields can be selected for theLand Use field. The user

should specify the field corresponding to unique landuse codes.

Impervious Cover Field: If your land use theme has a field with values of impervi-
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ous cover, you should click in the checkbox forImpervious Cover Field and then select

the corresponding field in the dropdown list.

Note: If you want to calculate the impervious percentage for each subbasin based on

the impervious percentages in Look Up table, then add a field in the Land use shapefile

and populate it with -99. Check the Impervious Cover Field checkbox and select the

added field from the dropdown list.

Edit Land Use Theme: Select theEdit Land Use Themebutton and thenDraw

Polygon. To complete the drawing of each polygon,double-click on the map. When you

are finished with drawing polygonsright-click on the map to go back to the previous

window. When the previous window appears, selectApply . Another window appears

asking for the new value of landuse. Select the new value and thenOK . A new layer

with updated landuse values will be added into the map and will be used for further

calculation.

Soils: Select the browse for folder button (folder icon) in theSoils frame. The

shapefile can be loaded from disk or added from the map.

SoilType: Various fields can be selected forSoilType. The user should specify the

field corresponding to the unique soiltype codes.

A percentage, B percentage, C percentageandD percentage:These fields should

be chosen from the fields of the soiltype theme. They should store the value of percent-

ages of A, B, C or D components in each type of soil.

Edit Soil Data Theme: Select theEdit Soil Data Theme button and thenDraw

Polygon. To complete the drawing of each polygon,double-click on the map. Upon

completion of all polygons,right-click on the map. When the previous window appears,

selectApply . Another window appears asking for the new value of the soil field. Select

the new value and thenOK . A new layer with updated soil type values will be added into

the map and will be used for further calculation.



133

WaterShed Theme:Select the browse for folder button (folder icon) in theWater-

Shed Themeframe. The shapefile can be loaded from disk or added from the map.

Look Up Table: This table has curve number values for various combinationsof

landuse and soiltype. The Look Up Table should have the following fields, or it will

display a message box listing the missing information:

Landuse code field – should have same name as specified in landuse field in landuse

frame

CNA – Curve number if soil consists of group A only

CNB – Curve number if soil consists of group B only

CNC – Curve number if soil consists of group C only

CND – Curve number if soil consists of group D only

Impervious – which have the impervious cover percentages for various combinations

To use the default Look Up Table make sure that it is saved on disk at the same

location as WSDelineation.dll.

If everything is appropriate, theCalculate Curve Numbersbutton will be activated.

After selecting it, a message box will appear saying the calculations were successful.

If you open the attribute table of theWatershed layer you will find three additional

fields:

AverBCN– which is the average Base CN for each subbasin. Base Curve Number

the curve number for 0% impervious cover.

AverCN– which is the average CN for each subbasin.

AverImpC– which stores the average impervious cover for each subbasin. This

field will also have zero values if you do not have impervious cover percentages in the

landuse theme. To calculate it, you should manually add the field in your existing landuse

shapefile, populate it with pertinent values and select in the GUI shown above.
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b) Using Raster for Land Use and Soil Type

Land Use: Select the browse for folder button (folder icon) in theLand Useframe.

Choose ‘Select From View’ option, a new listbox will appear. Choose ‘Grid’ option and

then select the Land Use grid from the map.

When working with grid, the button and dropdown list boxes will not be activated.

The impervious cover will be calculated based on the Impervious cover values given in

the Look Up table.

Soil Type: Select the browse for folder button (folder icon) in theSoil Type frame.

Choose ‘Select From View’ option, a new listbox will appear. Choose ‘Grid’ option and

then select the Land Use grid from the map.

When working with grid, the button and dropdown list boxes will not be activated.

Note: Soil type Grid should have a field namedMUID which contains the identifier

for soil type. This identifier will be used to get the percentages of various groups of soils

from a separate table explained later in the document.

HSGTable: This table contains the percentages of A, B, C and D soil groupsin the

various soils present in the study area. The table must be stored in the same location as

the Soil Type grid on the disk. Also, the name of the fields in itshould follow the format

shown below.

WaterShed Theme:Select the browse for folder button (folder icon) in theWater-

Shed Themeframe. The shapefile can be loaded from disk or added from the map.

Look Up Table: It should follow the same specification as mentioned for using

shapefiles.
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If everything is appropriate, theCalculate Curve Numbersbutton will be activated.

Click this button and after completion a message box will appear reporting the success

of calculations.

To change curve number:This tool allows the user to change the curve number by

changing the impervious cover. Select the subbasin(s) for which you want to change the

curve number. Go to the toolbar and click the ‘Change Impervious Cover’ button.

A window will appear in which choose the watershed layer fromthe dropdown list.

The boxes below the dropdown list will be populated showing the existing values of

Impervious Cover and Curve Number for the selected subbbasins.
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To change the value for subbasin ‘R110110’, click on the box below NEW IC col-

umn corresponding to the subbasin. Enter the new value of Impervious Cover percentage

and press enter or move to another box. The box below theNEW CN column will show

the new curve number. Mark the check box next to the subbasin ‘R110110’, if updating

curve number for this subbasin only is desired, to update thevalue in theWatershed

Themeand pressSave Chagebutton. A message box saying ‘Successfully Stored’ will

appear.

20. Grid Cell Parameter File

This tool creates a grid cell parameter file to support the ModClark runoff transform

option in HMS. It needs theprojected fishnet overlaying the watershed. To begin, add

thefishnetshapefile to the map document.

SelectGenerate Grid File Parametersin the dropdown menu of the PrePro2004

tool. In box that appears, select thefishnet layer, chose the output coordinatesHRAP or

SHG and then press OK.

Upon completion, a window appears saying that the grid cell parameter file has been

successfully created.
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21. Gage Weights calculation

The weights of precipitation gages for each subbasin are calculated based on the

thiessen polygons. This tool works in continuation with thewatershed delineator tool

only. If the ArcMap is closed after running watershed delineator and opened again to run

‘Calculate Gage Weigths’ tool, it will not work.

Note: Before running this tool make sure that3D Analyst Extensionis enabled. To

enable it go to Tools–>Extensions and check the box for 3D Analyst.

The red stars are the gages for which weights have to be calculated. On clicking the

command, a window will pop up; select the gage layer from dropdown list and ‘Gage-

Code’ field from another dropdown list. Press ‘calculate’ button to get the gage weights.

The calculated gage weights are stored in a separate shapefile ‘GageWeights’. The

attribute table of the shapefile looks like the figure below.

The highlighted fields ‘GageCode’, ‘HMSCode’, and ‘GageWt’ arethe fields to

relate the gage and its weight with subbasin.
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22. Export Data to IDM

It is recommended to use empty geodatabases before exporting the calculated data.

They can be emptied using HMSToIDM tool from menu Tool/IDM/HMS, choosing the

basin and project geodatabase, checking the boxes for all the files and clicking ’Initialize

Geodatabase Records’. Close the window.

Click PrePro2004 — Export Data to IDM. After clicking Export Data to IDM

in the dropdown menu of the PrePro2004 tool, a wizard appears. In this wizard, se-

lect the folder icon to browse to the Basin geodatabase (located in Tutorial\Data\Input

Data\Geodatabases). Specify the name of the basin in theName of Basin (basin-

code): textbox, browse to the Project geodatabase (located in Tutorial\Data\InputData

\Geodatabases) and then select theEXPORT button to continue. Success will be re-

ported by a message box.

To check the exported data, open ArcCatalog and locate Basin geodatabase and

Project geodatabase. Check the feature classes inside the feature dataset and tables in

the Basin geodatabase for subbasin, reaches, junctions, sources and reservoirs. Check

the Project geodatabase to for gage weight parameters and grid cell parameters. To learn

more about geodatabases, user is referred to HEC-HMS IDM located at http://www.crwr.

utexas.edu/gis/gishydro04/.

The next sections describe the features of the Tools/IDM/HMS tool in the same

manual format.

23. Calculate Parameters (Menu Tool/IDM/HMS)

This tool calculates the Time of Concentration for each subbasin based on the param-

eters calculated during watershed delineation process.This calculation can be performed

if the watershed layer is having curve number values. Select the Calculate Parameters

button in the dropdown menu of the Tool/IDM/HMS, a wizard shown below will appear.
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Browse to the Basin Geodatabase by pressing the browse button (with folder icon)

and press calculate. Upon completion, a window appears saying Parameter Calculated

Succefully.

The currently calculated parameter is subbasin lag time using the National Resource

Conservation Service (NRCS) lag equation:

tL =
l0.8(1000 − 9CN)0.7

1900CN0.7S0.5

where,tL = the basin lag time in hours,l = the length of the longest flow path,CN

= the curve number for the subbasin, andS = the average subbasin slope (%).

After running this tool the tables affected are:

LossRateSCS (located inside Basin geodatabase) will be populated withthe average

curve number and impervious cover percentages.
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TransformSCS (located inside Basin geodatabase) will be populated withthe sub-

basin lag time.

24. Data preparation to create HMS input

1. Update HMSSubbasin feature class

If you look HMSSubbasin feature class inside the Basin geodatabase using ArcCat-
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alog, it should look something like the figure below.

The fields LossRate, hTransform and Baseflow are empty. The LossRate field,

hTransform field, and Baseflow field stores the name of the lossrate method, transform

method, and baseflow method for each subbasin, respectively. If we create the basin

file at this point, we will not be able to transfer the calculate SCS curve numbers and

calculated lag time.

NOTE: In order to transfer the parameters for Lossrate methods, Transform meth-

ods and base flow methods for subbasins, follow the steps given below

1. Open ArcMap, add HMSSubbasin feature class (located inside HMSBasinFea-

tures feature dataset in Basin geodatabase) to the map. Remember to use the same geo-

database in which data was exported.

2. Activate the editor toolbar from Tools→ Editor Toolbar.

3. On the editor toolbar, go to menu item Editor→ Start editing and choose the

Basin geodatabase for editing and press OK.

4. Right click on the HMSSubbasin layer, click on ‘Open Attribute Table’ to open

the table for editing.

5. Right click on the field LossRate.
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6. Click on the ’Calculate Values’

7. Type ”SCS” in the text box and press OK. (see figure below). The field LossRate

will be populated.

8. Now, right click on field hTransform. Repeat steps 6 and 7.

9. Now, right click on field Baseflow. Repeat step 6 and step 7 with“None”. At this

point, the attribute table of HMSSubbasin should look like the figure below.

If you want to use methods other then mentioned above, follow the table give below.

Remember that the fields are text fields and the values are casesensitive.
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Field Required Option Value to use

LossRate

None None

Green and Ampt Green and Ampt

Initial and Constant Initial+Constant

Deficit and Constant Deficit Constant

Soil Moisture Accounting Soil Moisture Account

Gridded SMA Gridded Soil Moisture Account

Gridded SCS Curve NumberGridded SCS

SCS Curve Number SCS

hTransform

Clark Unit Hydrograph Clark

Modified Clark UH Modified Clark

SCS Unit Hydrograph SCS

Snyder Unit Hydrograph Snyder

Kinematic Wave Kinematic Wave

User-Specified S-Graph User-Specified S-Graph

User-Specified UH User-Specified UH

BaseFlow

None None

Recession Recession

Monthly Constant Monthly Constant

Bounded Recession Bounded Recession

SMA Groundwater SMA Groundwater

2. Update HMSReach feature class

If you look HMSReach feature class inside the Basin geodatabase using ArcCatalog,

it should look something like the figure below.

The field Route is empty. The Route field stores the name of the routing method for
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each reach. If we create the basin file at this point, we will not be able to transfer the

routing parameters, calculated later in the exercise, for reaches.

NOTE: Transfer routing method parameters for reach to basin model.

1. Open ArcMap, add HMSReach feature class (located inside HMSBasinFeatures

feature dataset in Basin geodatabase) to the map. Remember to use the same geo-

database in which data was exported.

2. Activate the editor toolbar from Tools→ Editor Toolbar.

3. On the editor toolbar, go to menu item Editor→ Start editing and choose the

Basin geodatabase for editing and press OK.

4. Right click on the HMSReach layer, click on ‘Open Attribute Table’ to open the

table for editing.

5. Right click on the field Route.

6. Click on the ’Calculate Values’

7. Type ”Lag” in the text box and press OK. (see figure below). Thefield Route will

be populated.

8. At this point, the attribute table of HMSReach should looklike the figure below.

If you want to use methods other then mentioned above, follow the table give below.

Remember that the fields are text fields and the values are casesensitive.
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Field Required Option Value to use

Route

None None

Kinematic Wave Kinematic Wave

Lag Lag

Modified Puls Modified Puls

Muskingum Muskingum

Muskingum Cunge 8 Point Muskingum Cunge 8 Point

Muskingum Cunge StandardMuskingum Cunge Standard

Straddle Stragger Straddle Stragger
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a) Reach routing parameters

In this section, it is assumed that we want to choose Lag as therouting method

for all the reaches. A Visual Basic code is provided to facilitate the population of Lag

parameters inside the geodatabase. FOLLOW THE INSTRUCTIONSTO ACHIEVE

THE DESIRED RESULTS.

1. Open ArcMap (if it is closed)

2. AddHMSReachfeature class(located inside HMSBasinFeatures feature dataset

in Basin geodatabase)to ArcMap. Also addRouteLag table to the map located inside

Basin geodatabase.

3. Make sure HMSReach is the topmost layer in the map and RouteLag is the only

table in the map.

4. Then gotoTools—Macros—Visual Basin Editor. On the left panel you will see

Normal (Normal.mxt), expand it. You will see two folders ArcMap Objects and Modules.

Expand ArcMap Objects and double click onThisDocument. On the right panel you will

see an editor. Copy the code provided in the text file CalculateRouteLag.txt (located in

folder PrePro2004) and paste it on this editor.

5. Go back to ArcMap (which might be minimized). Go toTools—Macros—Macros

you should get a window shown below.

Change to Normal(Normal.mxt) in Macros in: dropdown list. You should be able to

see the macro namedThisDocument.CalculateRouteLag. Click Run.

6. An input box to enter the value of reach velocity to be used for lag calculation in

m/s shown below. Enter the desired value and press OK.

7. A message box will appear reporting the success.

8. Now you are ready to create HMS input files.

25. IDMtoHMS

The tools corresponding to this menu item create the input files for HEC-HMS from
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the data stored inside the Basin Geodatabase.

a) Basin File

On clicking the Basin file button, wizard shown below will appear. Using the browse

buttons (with folder icons) choose the Basin Geodatabase (located in Tutorial\Data\Input

Data\Geodatabases), the path and name to the Basin file, Map file and GridCell file. Ei-

ther all or some of the files could be created based on the user requirement.

Press the create button and after some time a window will appear saying Files suc-

cessfully created. The files are ready to import into HMS.

b) Meteorological File

On clicking the Meteorological file button a wizard shown below will appear. Using

the browse buttons (with folder icons) choose the Project Geodatabase and the path and

name to the meteorological file. Press the create button to create file.

Note: The meteorological file could only be created when there is data inside the

Project Geodatabase. This tool is helpful to recreate the meteorological files for HMS
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model which was already exported inside the geodatabases using the HMStoIDM tool

(discussed later in the document).

c) DSS File

On clicking the DSS file button a wizard shown below will appear.

Either Paired Value Data or Time Series Data can be transferred at a time. Check

the box to transfer the type of data and browse to the Basin geodatabase using the browse

button (with folder icon). All the Paired Data or Time Seriesdata inside the geodatabases

will be read and showed as in the figure below.

Select the pathname(s) you need to transfer. Select the output DSS file which could

be existing file or created. Click the ‘Create DSS’ button. A message box reporting the

successful creation of DSS file will come up.

Congratulations, you have successfully delineated the watershed and stream network

from DEM, established topology, calculated parameters andcreated the HMS input files.

Now you are ready to work with HMS model.

26. Importing text files to HMS
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To utilize the files created in previous step to create an HMS model, follow the steps

given below:

(a) Open HMS, an interface titled ’HMS * Project Definition’ will appear.

(b) In the menu of the interface, go to File→ New Project, click on it to create a

new project.

(c) A window titled ’HMS * New Project’ will appear. Name the project as ’bull-

creek’. In the description write ’bullcreek model created using PrePro2004’. Then press

OK.

(d) Now, go to Component→ Basin Model→ Import and click on it.

(e) A window titled ’HMS * Basin Model * Import’ will appear. Browse, in the

right panel, to locate the basin file created in previous stepthen select the file in the left

panel and pressImport . A window shown below, should appear. The basin model is

successfully transferred to HMS.Do not close this window.

(f) On the window titled ’HMS * Basin Model - bullcreek’, go to File → Basin
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Model Attributes and click it. A window titled ’HMS * Basin Model * Attributes’ will

appear. Press the tab named ’Files’. Browse to the created mapfile (a file with extension

.map) and then pressOK .

(g) The window titled ’HMS * Basin Model - bullcreek’ should beshowing the map

along with the HMS elements, as shown in the figure below. Now,we can close this

window.

(h) On the menu of the window shown above, go to Parameters→ Loss Rate→

SCS Curve Number and click it. A window with the SCS method parameters for each

subbasin appears as shown in the figure below.

(i) Similarly to check SCS transform method parameters, go toParameters→ Trans-

form→ SCS UH. The window shown below will appear.

(j) Close the window titled ’HMS * Basin Model - bullcreek’.

(k) Before importing the Meteorological file we will define thegages. For this on

the menu of window titled ’HMS * Project Definition’, go to Data→ Precipitation Gages

and click on it.

(l) A window titled ’New Precipitation Record’ will appear. ChangeGageID as 0,

select ’External DSS Record’ and pressOK .
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(m) On pressing OK, a window titled ’DSS Pathname Select for 0’ will appear, press

Cancel. Another window titled ’HMS * Precipitation Gage Manager’ will appear. On this

window, go to Edit→ Add Gage and click on it.
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(n) Window titled ’New Precipitation Record’ will appear again, now change GageID

as 1, select ’External DSS Record’ and pressOK . A window titled ’DSS Pathname Select

for 1’ will appear, pressCancel.

(o) Repeat steps (m) and (n) forGageID as2. Then close the window titled ’HMS

* Precipitation Gage Manager’.

(p) To import the Meteorological file, in the menu of window titled ’HMS * Project

Definition’, go to Component→Meteorological Model→ Import and click on it. Browse

to the created file (with extension .met) and select the modelin the left panel of window

titled ’HMS * Meteorological Model * Import’, then pressImport . A window titled

’HMS * Meteorological Model’ will appear. In this window thevarious parameters for

’User Gage Weighting’ can be checked.

(q) This imported data, along with other information directly entered through HMS

interface will create a complete hydrologic model for Bull creek.
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27. Running HEC-HMS model

For running the HMS model, we need the routing parameters forreaches and precipitation

data for gages.

Precipitation Data

Downloading Precipitation Data

15-minute and hourly precipitation data can be downloaded from the National Cli-

matic Data Center’s NNDC Climate Data Online website. The sitehas data for 6,100

U.S. stations, and some non-U.S. stations. For this exercise, three text files are provided

BullA.txt, BullB.txt and BullC.txt with 15-min precipitation data. The general proce-

dure for obtaining these text files is explained here. To download 15-minute or hourly

precipitation data:

1. Go to the NNDC Climate Data Online website

2. Select ”Precipitation Data, 15 minute” (or ”Precipitation Data, Hourly”) under

theDataset/Product optionsection

3. Click the Access Data/Products button Wait a few moments for the next page to

load 4. Select the Country option choosing United States

5. Click Continue

6. Select your desired state under theselect a State/Provincesection

7. Choose the option forSelected Station in the state

8. Click Continue

9. Select the station(s) of choice, noting the period of record for each station You can

multi-select stations by holding the Ctrl key when clicking (e.g. San Antonio 417947)

10. Click Continue

11. Enter the date criteria and desired output format. The space-delimited format

works nicely if you want to view the data in your browser. The comma-delimited format

works nicely for opening text file in Excel (which is recommended for this exercise).
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12. Click Continue

13. Check the Inventory Review box and enter a valid email address

14. Click the Submit Request button 15. Make a note of the URL provided in the

ensuing web page When the data request has been processed, thedata can be accessed at

the URL provided. You will be notified when the data is ready at the email address you

entered.

16. Click on the URL

17. Click on the first Access URL, which links to the data file. Right click on it,

chose ’Save Target As’ and save the text file.

We suggest you read the dataset documentation, which is the last access link. The

15 minute documentation states that all precipitation values are in hundredths of inches

(value X 0.01 = inches). You can check the accuracy of the precipitation observation by

viewing the entry in the column labeled ”UN.” If it is HT, thenthe values are in stored to

the tenths place. If it is HI, then the values are stored to thehundredths place.

Working in Microsoft Excel

Note: For the purpose of exercise, the text files are providedwhich are created

from the data downloaded from NCDC website. If you want to use these files then skip

to step 15 of this section. Otherwise, follows the steps in order to download data from

website and creating text file.

1. Open Microsoft Excel.

2. Go to File→ Open, a dialog box titled Open will show up. Choose ’All Files

(*.*)’ in File of Types combobox. Browse to the text file BullA.txt (or file downloaded

above) and click open.

3. A wizard will show up as shown in figure below. Choose ’Delimited Option’.

Press Next.
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4. In the next dialog box, put a check mark for Comma and press next.

5. Press Finish in the next dialog. You should get the Excel sheet similar to shown

below.
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6. The above shown excel sheet shows the hourly precipitation data. Each row

corresponds to a single day along with data at every hour. At the end of the row you will

find 2500 in the ’TIME’ column, the field ’TOTAL’ is the total precipitation for the day.

For storing a constant interval time series to DSS, we need totell it the starting date and

time and the precipitation data.Go to Insert → Worksheet. A worksheet with name

Sheet1 should be added.

7. Go to Tools→ Marco→ Visual Basic Editor. On the left panel you will see the

files as shown below.

Expand theVBAProject (BullA.txt) , then expand Microsoft Excel Objects. Double

click on ThisWorkbook. The editor will show up on the right. Copy the code provided in

text file ArrangeData.txt(located in folder PrePro2004)and paste it in the editor. Close

the visual basic editor.

8. To run the above macro, go to Tools→ Macros→ Macro. You should get a

dialog box shown below. Select ’ThisWorkbook.ArrangeData’ and click onRun.

9. A message box saying ”Done” will appear OK. Now your Sheet1should look

something like this.

The first columns is having the data arranged from the matrix form in BullA sheet to

a linear form. The first value represents the precipitation data at starting date and starting
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time. The next value represents the data for next hour after the starting time.

10. Also the data obtained is in hundredth of inch, so we will need to convert it into

inches (as required by HMS). For this, divide the precipitation data in first column with

100 and store results in the column next to it. The highlighted column shown in the figure

below is the precipitation data in inches
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11. We need to create a text file which will be used for creatingDSS file. So to

create the text file, go to windows Start ’ Run and type Notepad.An empty notepad file

will come up.

Copy and paste the following lines

bullcreek.dss

/bullcreek/bulla/precip/01SEP1996/1Hour/obs/

inches

per-cum

01SEP1996 0100

where first line is the name of dss file to be created, second line is the pathname for

the data we are going store in it, third line is the units of data, fourth line is the data type

and fifth line is the starting date and time of precipitation data. For more information on

how to create these lines refer to DSSTS manual available from Hydrologic Engineering

Center’s website.

It should be noted that while creating your own text file with your own data,

replace the date in bold in the second line with the STARTING DATE of your data.

Also, replace the starting date and time in the fifth line with the starting date and

time of your data.

12. Select the second columns with all the existing rows in the Excel sheet as shown

in the figure above. Copy these values.

13. Paste these values below the line per-cum in the text file.It should look like the

file shown below.

14. Go to the end of the file and write END, press enter and writeFINISH. It should

look like the figure shown below.

15. Now our precipitation input file is ready. Browse to the folder Tutorial (obtained

from unzipping PrePro2004.zip file), you should have a filedssts.exe. This is and exe-
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cutable file which reads the data from text file and writes in the existing (or create new)

dss file. It should be noted that the input text file should be inthe same location as the

dssits.exe file is in. And also, the output dss file will be created in the same location

as dssits.exe is located.So either copy the executable to the folder where text file is

located or vice-versa.

16. Open the MS-DOS prompt (located at Start— All Programs—Accessories—

Command Prompt in Windows XP). Change your location where the dssits.exe file is

located. Type the following command and press enter.

dssts input = BullA.txt

Your command prompt should look something like this, reporting the creation of

records.

It should be noted that, I stored dssits.exe in ’C:\Documents and Settings\a0a1408\Desktop
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\PrecipData\’ folder along with the text file BullA.txt. Also bullcreek.dss file is also cre-

ated in the same location.

17. Similarly, create the dss records for BullB.txt and BullC.txt file. The commands

will be

dssts input = BullB.txt

dssts input = BullC.txt using one at a time.

Associating the precipitation data in HEC-HMS

1. Open HMS. Open the project created after importing the basin file and meteoro-

logical file created from PrePro2004.

2. On the menu go to Data ’ Precipitation Gages. A window titled ’HMS * Precipi-

tation Gage Manager’ will come up. Select the gage 0.

3. Go to Edit→ Source on the above shown window. A window should come up.

Browse to the ’bullcreek.dss’ file, press ’Generate Catalog’.Select the record with BullA

in pathname as shown in the window and press OK. Select the pathname with the starting

date of 01Sep1996.

4. Close the ’HMS * Precipitation Gage Manager’
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5. We have successfully assigned the precipitation data to the gage. Similar steps

will be followed to assign data to other gages. (BullB and BullC)

Running the HMS model

1. To use the gage weighting scheme the precipitation data should be regular. We

also need to assign temporal weights to gages for each subbasin. For this, double click on

the ’bullcreek’ meteorological model. A window titled ’HMS* Meteorological Model’

will show up. Choose the option Weights. Your dialog box should look like the figure

below.

2. Type the value of Temporal Gage Weight for each subbasin. To change the

subbasin use the dropdown list beside Subbasin. If there is one gage, use 1, if more then

1 then divide the 1 by the number of gages and assign equal temporal weight to each
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gage. After doing this for all the subbasins click Apply and then press OK.

3. On the HMS*Project Definition window go to Component→ Control Specifica-

tions→ New. A window titled HMS*New Control Specifications will comeup. Accept

the default values and press OK.

4. In the next window titled HMS * Control Specification type inthe date, time and

interval as shown below and Press OK.

5. On the HMS * Project Definition window, go to Tools→ Run Configuration. A

window titled HMS * Run Configuration will show up. Choose bullcreek as basin model,

bullcreek as meteorological model and control1 as control specification model. Accept

the default name for Run ID and press OK.

6. Now again go to Tools→ Run Manager, a window titled HMS * Run Manager

will come up. Select the Run ID created in previous step and press compute. The success

or failure of the model will be reported by a progress bar, followed by list of errors,

warning and/or notes.
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There are no errors while we ran the HMS model but there were some warnings

and notes. To remove these warning messages changes in the HMSparameters have to

be made from HMS interface, for this user is advised to refer the HEC-HMS Reference

Manual. The data used for the exercise should not be used for areal situation as it is

adjusted to create this exercise.

These materials may be used for research and educational purposes only. Please credit

the authors and the Department of Civil Engineering, Texas A&M University. All

commercial rights reserved. Copyright 2004: Texas A&M University.
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APPENDIX C

PREPRO2004 USER’S MANUAL - PART II

Prepared by Francisco Olivera, Ph.D., P.E., Srikanth Koka and Ashish Agrawal

Department of Civil Engineering, Texas A&M University

For steps to load toolbar in ArcMap, refer to PrePro2004 User’s Manual - Part I.

This exercise follows a manual format rather than an exercise format. It is being suc-

cessfully tested with Hydrologic Modeling System (HMS) version 2.2.2 and ArcView 9.0

(Product version: 9.0.0.538; ArcGIS Service Pack: 1 (build9.0.0.550). Using this man-

ual we can transfer the existing HMS model, in the text file format, to the geodatabases.

Further, the tools under IDMtoHMS menu item can be used to recreate the HMS model,

in text file format, from the data inside the geodatabases. This part of PrePro2004 is cre-

ated to facilitate archiving as well as streamlining of the older work done in HMS with

the new technology.

Data for this exercise can be located as follows:

Tutorial\Data\InputData\Geodatabases

Basin.mdb –an Access geodatabase to store the information about the basin model of

HMS

Project.mdb – an Access geodatabase to store information about the meteorological

model, control model and project specific information of HMS

Tutorial\Data\ExistingHMSModel\HMSModel\SaladoUnified

SaladoUnified.hms– HMS project definition file
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SaladoUnified.gage –HMS gage information file

SaladoUnified.dss –HMS data storage system file

SaladoEntire WS.basin –HMS basin model file

SaladoEntire WS.met– HMS meteorological model file

HDR 100 yr.control – HMS control specification file

Example.mod – HMS grid cell parameter file to support ModClark option

Example.smu –HMS SMA unit file

Tutorial\Data\ExistingHMSmodel\Shapes

Saladow updated rosillo.shp –shapefile of subbasins for existing HMS model

Reach.shp-shapefile of reachs for existing HMS model

HMSJunction1.shp –shapefile of point elements of existing HMS model

Gage.shp –shapefile of gage of existing HMS model

Getting to know the data

For the exercise we are using an HMS model for Salado Creek basin located in

Bexar County, TX obtained from PBS&J, Austin. We will open the HMS model and go

through its different components, briefly discussing them.

1. Open HMS using windows start menu, an interface titled ’HMS * Project Defini-

tion’ will appear.

2. In the menu of the interface, go to File→ Open Project, click on it to open the

project.
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3. A window titled ’HMS * Open project’ will appear. Go to tab ’Unlisted Project’,

assuming we are opening the project first time. If the projectis already opened then it will

show up under tab ’Project list’ with ProjectID as ’Salado Unified’. On the right panel

browse to the directory //Tutorial/Data/ExistingHMSModel/HMSModel/SaladoUnified,

on the left panel the project should appear as shown in the figure below. Select the project

by clicking on it. Press ’Open’

4. After clicking open, you should get a message box shown below.
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This error is shown since the project is not able to map the DSSfile. DSS is Data

Storage System file which stores the paired value and time series data, for example

storage-flow, elevation-storage, flow-time etc. Press OK. AHMS interface will appear

which looks like the figure below.

5. On the above shown interface, go to File—Exit to close the HMS model. We need

to change the path of DSS file in the text files to avoid this error. Proceed to next step.

6. Open the window explorer and browse to folder ...//Tutorial/Data/ExistingHMSModel

/HMSModel/SaladoUnified, it should look something like figure shown below. Youwill

see a file SaladoUnified.dss, note the complete path for this file. For me, the path is
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something like

C:\Documents and Settings\a0a1408\Desktop\ExistingHMSModel

\HMSModel\SaladoUnified\SaladoUnified.dss

For you it should be ending something like this ...\Tutorial\Data\ExistingHMSModel

\HMSModel\SaladoUnified\SaladoUnified.dss

7. Right click on the file SaladoEntire WS.basin and open it with notepad.
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The file should look something like the figure shown below.

See the 5th line from top, it stores the path of the DSS file. Replace the pathname

with the compete path of DSS file on your hard disk noted above.The new file should

look like the figure below, save it and close the file.

8. Similarly, right click on the file SaladoUnified.hms to open it with notepad.
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Replace the pathname in the 4th line of the file. See figures below.

9. Similarly, right click on the file SaladoEntire WS.met to open it with notepad.

Replace the pathname in the 6th line of the file. See figures below.



182

10. Similarly, right click on the file SaladoEntire WS.met to open it with notepad.

Replace the pathname in the 6th line of the file. See figures below.

11. Now we are ready to open the project once again in the HMS. Repeat steps 1, 2,

and 3. You should be able to see this window without any critical error warnings.
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12. Double-click on the Salado Entire WS in the basin model widow. A window

with basin model will appear as shown below. The basin model stores the elements

involved in the project.

Our HMS model is having subbasins, junctions, reaches, reservoirs and diversion.

Zoom into the view using the tools provided on the window above. Examine the various
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elements.

13. On the above window, go to Parameter—Element List, a window shown below

will appear. Scroll in this window vertically and horizontally, to see the downstream

element to each element. Note the loss rate method (SCS) and transform methods (SCS)

for subbasins and the routing method (Muskingum Or Modified-Puls) for reaches. This

table summarizes the information stored in the basin model.

14. Now we will see the meteorological data. Double-click onSaladoEntire WS

under the meteorological model panel. A window shown below should appear.
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The precipitation method used is User Hyetograph and each subbasin is getting the

precipitation data from Gage 1. Click cancel to close this window.

15. To see the gage data, on the window titled ’HMS * Project Definition’ go to

Data—Precipitation Gages and click on it. A window shown below will appear.

16. On the above shown window go to View—Graph and click on it.A window will

appear, click ’New Time Window’ button. A window shown belowwill appear. Press the

button ’Set’. The text boxes below it will be filled. Change theEnd Time from 17:35 to

17:00. We are doing this because the precipitation data is hourly. Click the OK button.

You will see the graph as shown in figure below.

Click close to close the graph. Click close on the window titled’HMS * Precipitation

Gage Manager’.
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17. Now we will see the control specifications. Double-clickon ’HDR 100-yr.hc1’

in the control specifications tab. A window shown below will appear.

The control specification window store the time period and time step for the calcu-

lation. Click Cancel to close this window.

18. We have seen all the three components required to create aHMS model. To

run the model you can go to View—Run Manager in the window titled ’HMS * Project

Definition’. A window will appear, select ’Run 1’ and click compute. The model will

run successfully with some warnings. Since no attempt is being made to calibrate this

model, these warnings appear. Close all the windows opened for HMS model and close

the HMS interface.
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HMS to IDM

In this section we will use the PrePro2004 tools to export theabove discussed HMS

model to geodatabases.

1. This tool read the input/output files of HEC-HMS and store data inside the Basin

and Project Geodatabases. Upon clicking the menu item ’HMS to IDM’ a wizard shown

below will show up.

2. Browse to the Basin geodatabase (located inside folder Geodatabases in Tuto-

rial/Data/Input Data) by clicking on the browse button (with folder icon) for choosing

the Target Basin Geodatabase.

3. Browse to the Project geodatabase (located inside folder Geodatabases in Tuto-

rial/Data/Input Data) by clicking on the browse button (with folder icon) for choosing the

Target Project Geodatabase.

4. Select all the check boxes next to the files to import insidethe geodatabases. The

files for which check boxes are checked will only be transferred to geodatabase. One or

more check boxes can be checked based on the requirement of the user.

5. Browse to basin model files using the browse buttons locatedon right side of the

text boxes. Choose the files from top to bottom in the order listed here,

• SaladoEntire WS.basin

• Example.mod

• SaladoUnified.hms

• SaladoEntire WS.met

• SaladoUnified.pdata

• Example.smu
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• SaladoUnified.dss

• SaladoUnified.gage

6. Click on the Initialize Geodatabase Records button to cleanthe geodatabases.

Press ’YES’ for all the message boxes that come up.

Initialize Geodatabase Records:By clicking on this button the records corre-

sponding to the chosen check boxes will be deleted from the geodatabases. This be-

comes imperative when we are working with personal geodatabases. We want to keep

each HMS project in a separate set of geodatabases. To createthe clean geodatabases,

check all the check boxes and press this button. Several message boxes may show up to

make sure that you want to delete the data.

7. Select the option of ’Paired Data’ inside frame Type of Data Transfer.

If HMS DSS File is needed to be transferred one of the options from Type of Data

Transfer should be chosen.

• Paired data

• Time Series Data

8. Press button ’Set up DSS Query’, the form shown below will show up. Type

’0010S’ in B-Part and ’STORAGE-FLOW’ in C-Part, then press Finished button. It

should be noted that the querying is case sensitive, so make sure you type exactly what is

shown in the figure below. Here we will be transferring the storage-flow data for element

0010S in the HMS model to table in geodatabase. The values in the text boxes of the

window depends on what data do we want to transfer and for which element and/or for

what time period.

Set up DSS Query: A form will show up. A, B, C, D, E, F parts (one or more,

depending on your query) should be specified. To set up the query, open the DSS file
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with HecDSSVue (software available from HEC website,http://www.hec.usace.army.mil/

software/hec-dss/hecdssvue-download.htm ) and look for the pertinent data and values of

corresponding parts. Based on these values query should be created using the window

titled ’DSS Query Setup’

9. Click on the buttonImport HMS Data : This button will extract the file path

depending on the DSS query as well as other files selected and import it to one of the

geodatabases (depending on the data type). After some time the window shown below

will appear reporting the success.
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10. To see the data transferred to geodatabases, open ArcCatalog and browse to

the folder where geodatabases are located (...\Tutorial\Data\InputData\Geodatabases).

Select the different tables and feature classes to see the data inside them in basin as

well as project geodatabase. The figure shown below shows thecontent of table HMS-

BasinHeader.
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The figure below shows the contents of ProjectHeader table located inside Project

geodatabase.

11. To transfer the shapes data to geodatabases, go back to tool window titled ’Trans-

fer Parameters from HMS Project’. Click on the buttonImport shapes Data: This will

open a window titled ’ShapesToHMS’ , where the source of shape files has to be specified.

This source could either be a geodatabase (contain feature classes) or shapefile workspace

(contain shapefile). Here we are using shapefiles, so browse to the folder where shapefiles

are stored and double-click on that folder. Browse to the folder ’Shapes’ located inside

Tutorial/Data/ExistingHMSModel. Make sure to double-click on the folder ’Shapes’ in

the window shown below and pressOK .
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12. A window titled ’ShapeToHMS’ will show up. Check the six check boxes as

shown in the figure below. Target geodatabase and feature classes are already shown on

the right side of form. The source ’shapefile/feature class name’ should be specified for

corresponding feature class in target geodatabase. Also for each shapefile in source data

’Match Field’ should be specified which will correspond to ’HMSCode’ in corresponding

feature class of target geodatabase. Here you will need to change the name of Source

feature class as follows:

HMSJunction1 - corresponding to HMSJunction

HMSJunction1 - corresponding to HMSDiversion

HMSJunction1 - corresponding to HMSReservoir

Saladow updatedrosillo - corresponding to HMSSubbasin

Reach - corresponding to HMSReach

Gage - corresponding to HMSGage

After changing the names, pressTransfer Shape Databutton.

The progress of transferring shapes will be shown and a message reporting the suc-

cess will come up.

13. Congratulations, you have successfully transferred thedata and shapes for ex-
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isting basin model to geodatabase. To check the successful transfer of data Basin and

Project geodatabases should be checked using ArcCatalog as shown in the figure below.
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To recreate the HMS model from data stored in geodatabase, refer to ’IDM to HMS’

in PrePro2004 User’s Manual - Part I.

These materials may be used for research and educational purposes only. Please credit

the authors and the Department of Civil Engineering, Texas A&M University. All

commercial rights reserved. Copyright 2004: Texas A&M University.
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